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Thank you for choosing Epiphan!  

At Epiphan Systems Inc. (“Epiphan”), product function and quality are our top 

priority. We make every effort to make sure that our products exceed our 

customers’ expectations.  

Product Feedback  

We regularly contact our customers to ensure product performance and 

reliability. We strive to continually enhance our products to accommodate your 

needs. We welcome your feedback and suggestions for product improvements. 

You can email your comments to info@epiphan.com. 

Specifications  

You can go to the Frame Grabbers page of the Epiphan website to get 

information about the VGA2Ethernet.  

Warranty  

All Epiphan Systems products are provided with a 100% return to depot warranty 

for one year from the date of purchase.  

Technical Support  

Epiphan is staffed by a professional support team. If, after checking the FAQs 

for your product on the Epiphan website and re-installing the Epiphan driver 

software (where applicable), you continue to have outstanding issues, email a 

problem report to support@epiphan.com. To help us solve the problem 

efficiently, include the following info:  

• Your VGA2Ethernet serial number.  

• The behavior of your VGA2Ethernet LED indicators.  

• Technical description of the signal source including resolution, refresh 

rate, synchronization, type of hardware.  

• Complete description of the problem you are experiencing.  

 

Copyright © 2011 Epiphan Systems Inc. All Rights Reserved. 
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Terms and Conditions 
This document, the Epiphan web site, and the information contained therein, 

including but not limited to the text and images as well as Epiphan Systems Inc's 

trademarks, trade names and logos are the property of Epiphan and its affiliates 

and licensors, and are protected from unauthorized copying and dissemination 

by Canadian copyright law, United States copyright law, trademark law, 

international conventions and other intellectual property laws.  

 

Epiphan, Epiphan Systems, Epiphan Systems Inc., and Epiphan logos are 

trademarks or registered trademarks of Epiphan Systems Inc., in certain 

countries. All Epiphan product names and logos are trademarks or registered 

trademarks of Epiphan. All other company and product names and logos may be 

trademarks or registered trademarks of their respective owners in certain 

countries.  

 

Copyright © 2011 Epiphan Systems Inc. All Rights Reserved. 

 
THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE 
ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION 
PACKET OR PRODUCT INSTALLATION SOFTWARE PACKAGE THAT 
SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY 
REFERENCE.  IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE 
OR LIMITED WARRANTY, CONTACT YOUR EPIPHAN REPRESENTATIVE 
FOR A COPY. 
 
PRODUCT DESCRIPTIONS AND SPECIFICATIONS REGARDING THE 
PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT 
NOTICE. EPIPHAN PERIODICALLY ADDS OR UPDATES THE INFORMATION 
AND DOCUMENTS ON ITS WEB SITE WITHOUT NOTICE. ALL 
STATEMENTS, INFORMATION AND RECOMMENDATIONS ARE BELIEVED 
TO BE ACCURATE AT TIME OF WRITING BUT ARE PRESENTED WITHOUT 
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED.  USERS MUST TAKE 
FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS. 
 
LIMITATION OF LIABILITY 
UNDER NO CIRCUMSTANCES SHALL EPIPHAN BE LIABLE FOR ANY 
INCIDENTAL, SPECIAL, CONSEQUENTIAL, EXEMPLARY OR OTHER 
INDIRECT DAMAGES THAT RESULT FROM THE USE OF, OR THE INABILITY 
TO USE, THIS PRODUCT OR THE INFORMATION CONTAINED ON THIS 
DOCUMENT OR PROVIDED ON EPIPHAN’S WEB SITE, EVEN IF EPIPHAN 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO 
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EVENT SHALL EPIPHAN'S TOTAL LIABILITY TO YOU FOR ALL DAMAGES, 
LOSSES, AND CAUSES OF ACTION RESULTING FROM YOUR USE OF THIS 
PRODUCT, WHETHER IN CONTRACT, TORT (INCLUDING, BUT NOT 
LIMITED TO, NEGLIGENCE) OR OTHERWISE, EXCEED THE AMOUNTS YOU 
PAID TO EPIPHAN DURING THE MOST RECENT THREE-MONTH PERIOD IN 
CONNECTION WITH AMOUNTS WHICH YOU PAID FOR USING THIS 
PRODUCT. 
 
INFORMATION AND DOCUMENTS, INCLUDING PRODUCT 
SPECIFICATIONS, PROVIDED IN THIS DOCUMENT OR THE EPIPHAN WEB 
SITE ARE PROVIDED "AS IS." SPECIFICALLY, BUT WITHOUT LIMITATION, 
EPIPHAN DOES NOT WARRANT THAT: (i) THE INFORMATION IS CORRECT, 
ACCURATE, RELIABLE OR COMPLETE; (ii) THE FUNCTIONS CONTAINED 
ON THIS WEB SITE WILL BE UNINTERRUPTED OR ERROR-FREE; (iii) 
DEFECTS WILL BE CORRECTED, OR (iv) THE EPIPHAN WEB SITE OR THE 
SERVER(S) THAT MAKES IT AVAILABLE ARE FREE OF VIRUSES OR 
OTHER HARMFUL COMPONENTS. EPIPHAN SPECIFICALLY DISCLAIMS 
ALL REPRESENTATIONS, WARRANTIES AND CONDITIONS, EITHER 
EXPRESS, IMPLIED, STATUTORY, BY USAGE OF TRADE OR OTHERWISE 
INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY, NON-INFRINGEMENT, TITLE, SATISFACTORY 
QUALITY OR FITNESS FOR A PARTICULAR PURPOSE. 

 

For additional terms and conditions, please refer to additional sections in this 

document. 
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1. Introduction  
The Epiphan VGA2Ethernet™ is a compact external DVI/VGA/composite frame 

grabber that is capable of capturing single link DVI and VGA signals at rates of up to 

60 frames per second. VGA2Ethernet also supports a stereo 3.5mm audio input. 

Designed for high speed and high precision military, medical and industrial 

applications, Epiphan Systems VGA2Ethernet uses the common RJ45 Ethernet port 

to interface itself with the target computer, allowing for up to 1 Gigabit transfer rates. 

 

 
 

This is the only frame grabber capable of capturing both DVI and VGA signals and 

sending the data over Ethernet. Using the latest state-of-the-art pre-compression 

technologies developed by Epiphan Systems specifically for the VGA2Ethernet, you 

are able to acquire diagnostic-quality 100% lossless images from any DVI/VGA/RGB 

source. 

This solution is also able to capture a composite video signal using a composite to 

VGA converter cable, purchased separately. 

The VGA2Ethernet is part of Epiphan’s complete line of video signal capture, 
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broadcasting and recording products.  For more information about all of Epiphan’s 

broadcasting products, please see the Broadcaster Products Overview on the 

Epiphan website.  

  

http://www.epiphan.com/products/broadcasting/
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2. Installation 
 

This chapter describes the basics of how to connect a VGA2Ethernet device to a 

VGA, DVI source and to an Ethernet network. 

The VGA2Ethernet device uses an Ethernet network connection to send captured 

image data to a video capture workstation. A video capture workstation is any PC or 

Mac on which you have installed the VGA2Ethernet drivers and application and that is 

connected to the same Ethernet network as the VGA2Ethernet device. 

VGA2Ethernet Hardware Features 

The VGA2Ethernet device is a 202mm x105mm x35mm (7.95”x4.13”x.1.38”) unit. 

The front panel includes power and capture activity LEDs, DVI In and Out, audio In 

and Out ports. The back panel includes 2 10/100/1000 Ethernet ports, and a power 

connector. 

Figure 1. VGA2Ethernet (front view) 
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Figure 2.  VGA2Ethernet (rear view) 

 
Figure 3. VGA to DVI Cable  
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Figure 4. Composite video to DVI converter (not included) 

 
 

 
Table 1: Connector, Interface and LED Descriptions 

 

ETH1  Primary 10/100/1000 Base-T RJ-45 auto-sensing Ethernet 

network port to connect the VGA2Ethernet device to an 

Ethernet network. The VGA2Ethernet device Ethernet port is 

auto-sensing. 

ETH2 Secondary 10/100/1000 Base-T RJ-45 auto-sensing Ethernet 

network port. This port is useful in case you need to configure 

the Ethernet Bridge when there is only one Ethernet 

connection. See Configuring the Ethernet Bridge For Use if 

You Have Only One Ethernet Connection. 

Power  Connect the AC adapter to the VGA2Ethernet power 

connector and to a power outlet 

LEDs Red LED: during operation the red LED blinks each time the 

VGA2Ethernet captures an image. You can use the red LED 

as an indicator that the VGA2Ethernet is capturing images. 

Green and blue LEDs:  when the VGA2Ethernet device first 

starts up, the blue LED lights up. A few seconds later the 

green LED lights up. After about another 20 seconds the blue 
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LED turns off, leaving the green LED on indicating that the 

VGA2Ethernet has started up and can start capturing 

images. During operation the blue LED blinks during video 

signal test operation and when the system tunes video 

parameters (e.g. VGA parameters) 

DVI In Connect a DVI source to the VGA2Ethernet device using a 

DVI cable. You can also connect a VGA source using a VGA 

to DVI adapter (included). To identify this cable please see 

Figure 3. If you want to connect a composite video source, 

use a composite video to DVI converter (not included). To 

identify this converter please see Composite video to DVI 

converter (not included).   

 

DVI Out This port allows you to check the presence of the signal. 

Connect a DVI monitor or projector using a DVI cable or a 

VGA monitor using DVI to VGA cable. 

 

Audio In Connect a microphone if you need to acquire audio. 

Audio 

Out 

Connect audio equipment (e.g. headphones or speakers) to 

control how audio stream is currently being captured by 

VGA2Ethernet. 

 

The VGA2Ethernet device will not capture images until a video capture workstation 

has found the device on the network and an application is requesting captured 

images. Even if the device is properly connected to a VGA source the red LED will not 

flash unless a video capture workstation is receiving captured images. 
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VGA2Ethernet Software Features 

Use the following software features to install and configure the 

VGA2Ethernet device. 

Factory default 

IP  

address and  

network mask 

 

IP: 192.168.255.250  

 

Netmask: 255.255.255.252  

Refer to the Restoring the VGA2Ethernet Default 

Factory Configuration section to know more about 

restoring factory default configuration. 

 

 

IP  

address  

from a  

DHCP  

server  

The VGA2Ethernet device can get an IP address on the 

network from a DHCP server if the network has one. If the 

network does not have a DHCP server, see the “If the Network 

Does Not Have a DHCP Server“ section.  

Web  

admin  

interface  

Use the VGA2Ethernet Web admin interface for changing the 

VGA2Ethernet IP address, making device adjustments, and 

installing new firmware. You can log into the Web admin 

interface by selecting Web config from the Network Discovery 

Utility or by opening a web browser and browsing to:  

http://< VGA2Ethernet_IP_Address>/admin/  

User Name: admin (no password)  

The Web admin interface is described in Chapter 3 of this User 

Guide.  

 

 



Installation  

 

11 VGA2Ethernet User Guide 

 

Optimizing VGA2Ethernet Performance  

For best performance, the capacity of the Ethernet connection between the 

VGA2Ethernet device and the video capture workstation should be as high as 

possible. The video capture workstation should have a 1-gigabit Ethernet port and the 

network should be a 1-gigabit network that includes high-bandwidth 1-gigabit 

switches.  

You can improve performance by using Ethernet cables with 4 pairs of wires. Cat5e or 

Cat6 cables are preferred to Cat5.  

You can also improve performance by connecting the VGA2Ethernet device directly to 

your video capture workstation. This connection makes all of the 1-gigabit bandwidth 

available for transmitting captured image data. See Direct Connection of 

VGA2Ethernet to Workstation. 

 

Connect and Power on a VGA2Ethernet Device 
To connect a VGA2Ethernet device you need:  

 A DVI or VGA video source. If connecting a VGA source, you will need to 

connect a VGA to DVI cable (provided). 

 A video capture station. 

 An Ethernet connection between the VGA2Ethernet device and the video 

capture workstation (in case the workstation is not located near 

VGA2Ethernet). The video capture workstation and the VGA2Ethernet device 

must be on the same Ethernet subnet. 
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Figure 5.  Connecting the VGA2Ethernet device to a network 

 
 

 

To connect and turn on the VGA2Ethernet device 

1. Use a DVI cable to connect the DVI source to the VGA2Ethernet DVI IN port 

on the front panel of the device. If connecting a VGA source, you will also 

need a VGA to DVI cable to connect the VGA source and the DVI IN port. 

You can use an active VGA splitter to split the video signal between a 

monitor and the VGA2Ethernet. The monitor should be connected to 

VGA2Ethernet through the DVI OUT port. Splitting the signal may reduce the 

image quality. 

2. Use a 3.5 mm mini-jack connector to connect the source’s audio output (if 

any) to an audio input of VGA2Ethernet. 

3. Use an RJ-45 Ethernet cable to connect the VGA2Ethernet Eth1 port to the 

10/100/1000 Base-T Ethernet network. For best performance, connect the 

VGA2Ethernet device to a 1000 Base-T Ethernet link to your network. The 

network must be running the TCP/IP protocol. You can optionally connect the 

VGA2Ethernet device directly to a video capture workstation 1-gigabit 

Ethernet port.  

4. Connect the power cable to the VGA2Ethernet device. The VGA2Ethernet 

device powers on and the power and image capture activity LEDs light up as 

the device starts up. 

5. Start up the video source. 
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6. Install the VGA2Ethernet drivers and the application (see Installing the 

Drivers and Application for Windows) and confirm that a 

captured image appears in the VGA2Ethernet user interface or Network 

Discovery utility. 

If a captured image does not appear, check the video source to make sure it is 

transmitting a video image. Also check the cable between the VGA2Ethernet and the 

video source to make sure it is connected correctly. 

 

Installing the Drivers and Application for Windows  

To view and record images captured by the VGA2Ethernet device, you must install the 

VGA2Ethernet drivers and application on a video capture workstation. The drivers and 

application include the following components:  

 The Epiphan device drivers that receive captured images from the 

VGA2Ethernet device over the network. 

 The VGA2Ethernet user interface that you can use to view, print, save, 

record and broadcast captured images.  

 The Network Discovery Utility that you can use to find Epiphan devices 

connected to the network. 

To install the drivers and application  

1. Find the latest drivers and application on the VGA2Ethernet download page: 

http://www.epiphan.com/products/frame-grabbers/vga2ethernet/download/  

2. Select Download VGA2Ethernet drivers and application to download the 

Installer package file. 

3. Double-click the installer package file to start the setup wizard and install the 

application.  

4. Follow the prompts. 

 

http://www.epiphan.com/products/frame-grabbers/vga2ethernet/download/
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Figure 6. VGA2Ethernet download page  

 

5. On the video capture workstation, run the VGA2Ethernet user interface. From 

the Windows Start menu select Start > Epiphan VGA2Ethernet > 

VGA2Ethernet GUI. The VGA2Ethernet user interface starts up and looks for 

VGA2Ethernet device on your network.  

Once the drivers and application are installed, you can start the VGA2Ethernet user 

interface by selecting Start > Epiphan VGA2Ethernet > VGA2Ethernet GUI. The user 

interface starts up and finds the VGA2Ethernet device if the device is connected to 

your network and operating.  

If the VGA2Ethernet user interface cannot find the device, you use the following utility:  

Start > Epiphan VGA2Ethernet > VGA2Ethernet DirectShow Configuration Utility.  
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This section assumes your network has a DHCP server and that the DHCP server 

gives the Epiphan device an IP address on your network. If your network does not 

have a DHCP server, see the “If the Network Does Not Have a DHCP Server“ section.  

 If the device is operating, has received an IP address from a DHCP server, and is 

connected to the network, the VGA2Ethernet user interface should find it and the 

image being captured by the device should appear on the user interface display.  

If the device is not capturing images, the device name and serial number still appear 

in the title bar and the IP address of the device still appears in the status bar, but 

instead of a captured image, the user interface displays No signal detected.  

Figure 7. VGA2Ethernet GUI interface 

 

 

Title Bar Displays the product name and serial number of the VGA2Ethernet 

device as well as the VGA mode and refresh rate of the video 

source. The title bar also displays the screen resolution and refresh 

rate of the video source. 

Menu Select commands from the menus. You can save and print 

captured images, start and stop recording, configure recording 

settings, and configure capture settings. 
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Toolbar Save, print, and copy a snapshot of the current captured image. 

Start, stop, pause and resume recording images.  

Captured Image The image currently being captured by the device. 

 

If the VGA2Ethernet User Interface Cannot Find the 
Device  

If the user interface cannot find the VGA2Ethernet device, make sure the device is 

turned on and check the network connections. If you find and correct the problem the 

device should automatically be detected by the user interface.  

If you still cannot see the VGA2Ethernet device, it may not have obtained an IP 

address from your DHCP server. See the “If the Network Does Not Have a DHCP 

Server“ section to change the device’s IP address.  

Finding the VGA2Ethernet Device Manually 
 

You can find the VGA2Ethernet device from the VGA2Ethernet user interface by 

selecting Select Device from the Capture menu in the VGA2Ethernet GUI application. 

The user interface lists all Epiphan devices that can be found on the network. Select 

the VGA2Ethernet device from the list and select OK. The VGA2Ethernet user 

interface connects to the selected device. 
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Figure 8. The VGA2Ethernet GUI’s Select Device window 

 

Using the Network Discovery Utility to Find the 
VGA2Ethernet 

You can also use the Network Discovery Utility to find the VGA2Ethernet device. From 

the Windows Start menu select Start > Epiphan VGA2Ethernet > VGA2Ethernet 

DirectShow Configuration Utility. When the utility starts up, select the Search button to 

find the Epiphan devices on your network.  

If the Epiphan device is operating, has received an IP address from a DHCP server, 

and is connected to the network, the Network Discovery Utility should find it and 

display the device’s IP address. Press the Web config… button to display the Web 

admin interface.  

If the device is capturing images, the current captured image should appear on the 

Network Discovery Utility interface and the status of the device should be Device OK, 

shown with a green indicator. If the device is not capturing images, the Device OK 

indicator can still appear but the Network Discovery Utility display will not show a 

captured image.  
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Figure 9. Network Discovery Utility connected to VGA2Ethernet  

 
 

Note: When you restart the Network Discovery Utility and an Epiphan device is found, 

the utility shows the status as Detecting and the indicator will be amber. If the Network 

Discovery Utility is not capturing signal from a previously found Epiphan device, the 

status will change to No Signal and the indicator will be amber. If the Network 

Discovery Utility cannot find a previously found Epiphan device, the status will change 

to Not Found and the indicator will be red. You should always select Search after 

starting the Network Discovery Utility to make sure it displays the most up-to-date 

information. 

 

Installing the Drivers and Applications for Mac OS X  

To view and record images captured by the VGA2Ethernet device, you must install the 

VGA2Ethernet drivers and application on a video capture workstation. This single 

download includes the VGA2Ethernet user interface command line capture application 

(v2u), VGA2Ethernet system preferences, and the QuickTime digitizer (vdig).  
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This section assumes your network has a DHCP server and that the DHCP server 

gives the Epiphan device an IP address on your network. If your network does not 

have a DHCP server, see the “If the Network Does Not Have a DHCP Server“ section.  

To install the drivers and application  

1. Find the latest drivers and software on the VGA2Ethernet download page, 

section Mac OS X: 

http://www.epiphan.com/products/frame-grabbers/vga2ethernet/download/  

2. Download the latest version of the drivers and application that will run on the 

video capture workstation.  

Tip: Make sure you note the download destination folder.  

3. Double-click on the .dmg file to unpack it if it doesn’t unpack automatically. 

4. Double-click on the .pkg file and follow the prompts. 

Note: The final step of the installation requires restarting the video capture 

workstation.  

5. On the video capture workstation, run the VGA2Ethernet user interface. From 

the Applications folder, select VGA2USB.app. The VGA2Ethernet user 

interface starts up.  

6. From the File menu, select Open Network Grabber. 

7. If you know the IP address of the device you can enter it manually. If you do 

not know the IP address of the device or you want to see a list of available 

VGA2Ethernet devices on the network, select the triangle next to the IP 

address field. 

8. Select a device from the list and select connect. 

9. If the device is operating, has received an IP address from a DHCP server, 

and is connected to the network, the image being captured by the device 

should appear in the capture window. If you have added a viewer password, 

you will be prompted to enter the password before the image being captured 

by the device appears in the capture window.  

http://www.epiphan.com/products/frame-grabbers/vga2ethernet/download/
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10. If the device is not capturing images, the device name appears in the title bar 

but instead of a captured image, the user interface displays No signal 

detected.  

If the VGA2Ethernet User Interface Cannot Find the 
Device  

If the user interface cannot find the VGA2Ethernet device, make sure the device is 

turned on and check the network connections. If you find and correct the problem the 

device should automatically be detected by the user interface.  

If you still cannot see the VGA2Ethernet device, it may not have obtained an IP 

address from your DHCP server. See the “If the Network Does Not Have a DHCP 

Server“ section.  

Direct Connection of VGA2Ethernet to Workstation 

In case you do not need to transfer captured video over the network you can use 

VGA2Ethernet as a simple frame grabber that allows capturing data from a 

VGA/DVI/composite source and recording it on a workstation. Use the RJ-45 Ethernet 

cable to connect VGA2Ethernet and the workstation. When the VGA2Ethernet device 

is connected directly to the video capture workstation, this connection provides local 

network simulation. You can find the VGA2Ethernet device on this network using the 

Network Discovery Utility. This configuration makes all of the 1-gigabit bandwidth 

available for transmitting captured image data.  
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Figure 10. VGA2Ethernet Direct Connection to Workstation 
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3. Windows VGA2Ethernet User Interface 

This chapter describes common functions and features of the Epiphan VGA2Ethernet 

user interface (the Windows 2000, XP, Vista and 7 versions). This chapter assumes 

that you have followed the instructions in the chapter 2 of this User Guide. To start 

using this chapter you should have:  

 A video capture workstation. 

 A connected VGA2Ethernet device.  

 Installed the VGA2Ethernet drivers and application on the video capture 

workstation as described in Installing the Drivers and Application 

for Windows. 

Finding VGA2Ethernet Drivers and Application 
Updates  

Find the latest VGA2Ethernet drivers and application on the VGA2Ethernet download 

page:  

http://www.epiphan.com/products/frame-grabbers/vga2ethernet/download/  

On these pages you will find the most recent versions of:  

 VGA2Ethernet documentation. 

 VGA2Ethernet firmware. See Upgrading the VGA2Ethernet 

Firmware. 

 Drivers and application software including the Network Discovery Utility. 

Follow the instructions in the Installing the Drivers and Application for 

Windows section to download and install the latest version of the VGA2Ethernet 

drivers and application.  

http://www.epiphan.com/products/frame-grabbers/vga2ethernet/download/
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Starting the VGA2Ethernet User Interface  

Before starting the VGA2Ethernet user interface the VGA2Ethernet device must be 

connected to the same network as the video capture workstation. The device should 

also be connected to power.  

To start the VGA2Ethernet user interface, from the Windows Start menu select Start > 

Epiphan VGA2Ethernet > VGA2Ethernet GUI. The VGA2Ethernet user interface starts 

up and looks for VGA2Ethernet devices on your network.  

If the VGA2Ethernet device is operating, has received an IP address from a DHCP 

server, and is connected to the network, the VGA2Ethernet user interface should find 

it and the image being captured by the VGA2Ethernet device should appear on the 

VGA2Ethernet user interface display.  

If the VGA2Ethernet device is not capturing images the device name and serial 

number still appear in the title bar and the IP address of the device still appears in the 

status bar but instead of a captured image, the VGA2Ethernet user interface displays 

No signal.  

As the VGA2Ethernet user interface starts, the following messages may appear on the 

VGA2Ethernet user interface window:  

 Capture device not found as the VGA2Ethernet user interface attempts to 

connect with VGA2Ethernet devices on your network. This message only 

displays for a few seconds unless the VGA2Ethernet user interface cannot 

find any devices or if all of the devices have a viewer password. To connect 

to a device with a viewer password, select Select Device or Connect Network 

Device from the Capture menu and when prompted enter the device’s viewer 

password. For more information, see Adding or Changing the Viewer 

Password.  

 Detecting Video Mode as the VGA2Ethernet user interface connects to a 

device and then determines the video mode of the device. 
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 Tuning Capture Parameters as the VGA2Ethernet user interface 

synchronizes and tunes capture settings and image adjustments (see 

Configuring Frame Grabber Adjustments for more information). 

 No Signal Detected if the VGA2Ethernet user interface connects with a 

VGA2Ethernet device that is not connected to an active video source. 

If the VGA2Ethernet user interface successfully connects to and synchronizes with the 

VGA2Ethernet device, it begins displaying captured images.   

Pausing, Copying, Saving, and Printing Images 

Once the VGA2Ethernet user interface is displaying images captured by the Frame 

Grabber, you can pause, copy, save, and print the current image.  

To pause and resume the image capture:  

1. Select Pause Capture from the Capture menu or from the toolbar select . 

2. While image capture is paused the VGA2Ethernet user interface stops 

receiving new images from the device. Pause also pauses video recording, 

image recording and web broadcasting. While paused you can save, print, 

and copy the captured image.  

3. To resume image capture select Resume Capture from the Capture menu or 

from the toolbar select . 

You can use the following procedure to copy the image currently displayed by the 

VGA2Ethernet user interface to the video capture workstation clipboard.  

To copy a snapshot of the current image:  

1. Select Copy from the Edit menu or from the toolbar select . You can also 

use the key combination CTRL+C. The current image is copied to the 

clipboard.  
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2. Paste the image into a document or other application as a bitmap image. The 

image is pasted as a device independent bitmap image.  

You can use the following procedure to save the current image as a .bmp, .png, or .jpg 

file on the video capture workstation. You can optionally pause image capture before 

saving an image.  

To save a snapshot of the current image as an image file:  

1. Select Save from the File menu or from the toolbar select  or use the 

key combination CTRL+S. The status bar shows the location and name of 

the saved file.  

2. The first time you save an image the Save As dialog appears and you can 

specify the file name, file type, and location of the saved image file.  

3. When you select Save again, the VGA2Ethernet user interface saves the 

new image with the same file name and location, overwriting the previously 

saved file. You can select Save As to save the image with a different file 

name, file type, or location or use the key combination CTRL+Shift+S.  

4. You can open the saved image file with most bitmap image editing 

applications.  

To print a snapshot of the current image:  

You can use the following procedure to print the current image on any printer that is 

connected to the video capture workstation. You can optionally pause image capture 

before printing an image.  

1. Select Print from the File menu, select  from the toolbar or use the key 

combination CTRL+P. The current image is sent to the default printer. You 

can select Print Setup from the file menu or use the key combination 

CTRL+Shift+P to select a different printer and set printer options.  
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Note: You can also configure the VGA2Ethernet user interface to invert colors for 

printing. From the Tools menu select Options then select the Display tab and select 

Invert colors for printing.  

Recording Captured Images  

You can record captured images as a video file or as a series of image files. Before 

recording captured images as a series of image files, you must configure recording 

options by selecting Options from the Tools menu, selecting the Recording tab, and 

selecting Record as Images. You should also select the image file format and other 

image file settings. See Recording Image Files  for the details.  

To record captured images as a series of image files: 

1. Select Start Recording from the Capture menu, from the toolbar select 

or use the key combination CTRL+R. As images are captured by the frame 

grabber they are recorded as a series of image files according to the image 

file settings on the Recording tab of the Options dialog (Tools menu). The 

Status bar shows the name and location of the last saved file. You can pause 

recording by using the key combination CTRL+U, selecting Pause from the 

Capture menu or from the toolbar. You can stop recording by selecting 

repeatedly Stop Recording from the Capture menu or from the toolbar. 

When you stop recording images, the status bar displays the number of 

image files saved.  

Before recording captured images as a video file you must configure recording options 

by selecting Options from the Tools menu, selecting the Recording tab, and selecting 

Record as Video. See Recording Videos for all the details.  
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To record captured images as a video file: 

1. Select Start Recording from the Capture menu or from the toolbar select  

. 

2. In the Save as dialog enter the file name, select the location for saving the 

video file, and click Save. 

As images are captured by the frame grabber they are recorded to the video 

file. The status bar shows the name and location of the video file. The status 

bar also displays the amount of time that the video has been recording and 

the number of frames (or images) recorded.  

When the size of the video file reaches the AVI file size limit (see AVI file size 

limit) the VGA2Ethernet user interface does one of the following:  

o stops recording 

o starts a new video file and continues recording ( Configuring Video 

File Recording Options describes how to specify the file name) 

o overwrites the original video file and continues recording. 

You can pause recording by selecting Pause Capture from the Capture menu 

or from the toolbar.  

You can stop recording by selecting Stop Recording from the Capture menu 

or from the toolbar.  

When you stop recording, the Status bar shows the name and location of the 

saved video file, the amount of time that the video file was recording, and the 

number of frames (or images) recorded. For example: Wrote 

c:\temp\example.avi (85 sec, 464 frames).  
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Menus  

This section describes the commands available from the following Windows 

VGA2Ethernet user interface menus:  

File Menu 

Use the File menu commands to save and print the current image displayed by the 

VGA2Ethernet user interface and to exit the VGA2Ethernet user interface. 

Save Save a snapshot of the current image to a file on the video capture 

workstation. Select a location for the file and select a file format. 

You can save the snapshot as a bitmap (*.bmp), portable network 

graphics (*.png), or JPEG (*.jpg) file.  

The first time you select Save after starting the VGA2Ethernet user 

interface you are prompted for a file name and you can change the 

file location and format. After saving the first file, every time you 

select Save, the video capture software saves a snapshot using 

the same file name in the same location replacing the previously 

saved file. When you select Save, the status bar shows the 

location and name of the saved file.  

 

Save As Save a snapshot of the current image to a file on the video capture 

workstation. Using Save As you can enter a file name and select a 

file location and format.  

Save As resets the file name, location, and file format used by the 

Save command and the Save snapshot toolbar button. When you 

select Save As the status bar shows the location and name of the 

saved file.  

Print Setup Configure printer settings used when you select the Print command 

or the Print snapshot toolbar button. You can also configure the 

VGA2Ethernet user interface to invert colors for printing. By 
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reversing or inverting the colors of an image, the colors are made 

complementary of the original value. After performing picture color 

inversion, black becomes white, yellow becomes blue, red 

becomes aqua. From the Tools menu select Options, then select 

the Display tab and select Invert colors for printing. 

Print Print a snapshot of the current image using the configured printer. 

Exit Close the VGA2Ethernet user interface. 

 

Edit Menu  

From the Edit menu you can copy a snapshot of the current image. You can also use 

the key combination CTRL+C. 

Copy Copy a snapshot of the current image to the video capture 

workstation clipboard. You can paste this image into a document or 

other application as a bitmap image. 

 

View Menu  

Use the commands on the View menu to control the parts of the VGA2Ethernet user 

interface window that are displayed.  

Toolbar Change the size of the toolbar icons or hide the toolbar. You can 

select small, large, or huge icons. If the toolbar is hidden, select an 

icon size to display the toolbar. 

Status Bar Enable or disable displaying the status bar. 

Full Screen Enable full screen mode (Ctrl+F). 

Image Only Change the VGA2Ethernet user interface to operate in the Image 

only mode. In the Image only mode the VGA2Ethernet user 

interface displays the captured image only. The window borders, 

toolbar, status bar and menu bar are not displayed. Scroll bars are 

displayed if required.  

The Image only mode can be useful for applications such as 



Windows VGA2Ethernet User Interface  

 

30 VGA2Ethernet User Guide 

 

integrating the VGA2Ethernet user interface into a custom system. 

You can still use all of the shortcut keys to save and print images, 

start and stop recordings, and to exit from the image-only mode. 

You can always press Alt+F4 to exit from the VGA2Ethernet user 

interface.  

You can also use the --borderless command line option to start the 

VGA2Ethernet user interface in image only mode. See Windows 

Command Line Options for information about this and other 

command line options.  

 

 

Capture Menu  

Use the commands on the capture menu to start, stop or pause capturing and 

recording images. From the capture menu you can also select the device that the 

VGA2Ethernet user interface receives captured images from if you have more than 

one Epiphan VGA2Ethernet or device connected to the network. You can also view 

image adjustment settings and VGA mode settings for the selected device.  

The record functions on the capture menu record the current image as a video or as a 

series of consecutive image files. Select Options from the Tools menu and use the 

settings on the Recording tab to configure what the VGA2Ethernet user interface 

records. 

Start recording Start recording the current image to a video file or a 

series of image files. 

Pause capture Pause or resume image capturing. If you select 

pause, the VGA2Ethernet user interface stops 

displaying new captured images and the image 

captured when you selected Pause is displayed. 

Pause also pauses recording a video, saving image 

files, and web broadcasting. Select pause again to 
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resume displaying captured images and resume 

recording or web broadcasting. 

Select device If you have more than one VGA2Ethernet device 

connected to the network, you can use Select 

Device or the key combination Ctrl+D to choose the 

device that the VGA2Ethernet user interface 

receives captured images from. The command finds 

and lists all of the VGA2Ethernet devices on your 

network. The list displays the serial number, device 

type, captured image resolution and frequency 

(status) and location of each device. You can also 

use this command to select the device to configure 

with the Configure Device command.  

If a viewer’s password has been added to the 

device, the device’s status is listed as protected in 

the select device list and you must enter the viewer’s 

password to connect to the device. See Adding or 

Changing the Viewer’s Password.  

 

Connect network device Enter or select the IP address of a VGA2Ethernet 

device on the network. Use this option or the key 

combination Ctrl+N instead of Select Device to 

connect to a device if you know its IP address. You 

can also use this option to attempt to connect to a 

device that does not appear in the select device list. 

Disconnect… Disconnect current device. 

Recent network devices Displays a list of recently viewed devices. 

Enable audio capture Allows capturing audio. You can also use the key 

combination Ctrl+A. 

Audio input device Select device where an audio signal is captured 
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from. 

Play captured audio Play audio that has been recorded. 

Configure device You can view image adjustments for the selected 

device. You configure image adjustments from the 

Web admin interface or from the Network Discovery 

Utility. See Configuring Image Adjustments for more 

information.  

You can also select and configure VGA modes for 

the selected device. See Configuring VGA Modes for 

more information.  

 

 

Tools Menu  

Use the Tools menu to customize basic VGA2Ethernet user interface operating 

settings. The Tools menu also contains commands for special functions such as 

broadcasting captured images over the Internet.  

Web Broadcasting Broadcast the images being captured by the 

VGA2Ethernet user interface over the Internet. See 

Chapter 9. "Web Broadcasting". 

Upload EDID to device Use this command to upload an extended display 

identification data (EDID) file to your device. See 

About EDID. 

Read EDID from device Use this command to read an extended display 

identification data (EDID) file from the device. 

Measure VGA Mode When requested by Epiphan technical support, you 

can use this command to display low-level information 

about the VGA mode that you are capturing with your 

Frame Grabber. You can copy this information into an 

email to send it to Epiphan technical support. 
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Options Configure video and audio recording, display, and 

sharing (Internet broadcasting) settings. See 

Recording, Display, and Sharing Options. 

 

 

Help Menu  

Use the Help menu to check for updates and to display information about the version 

of the VGA2Ethernet user interface that you are running.  

Note: Check for Updates function will only recommend an update if Epiphan 

recommends that you install a new version. This will happen if the latest version 

contains significant bug fixes or enhancements. If a new VGA2Ethernet user interface 

version only contains minor changes or if you are running the current version, Check 

for Updates may not recommend that you install a new version and will not display any 

information.  

 

Toolbar  

Use the toolbar to save, print, or copy the current captured image; to start, pause, and 

stop recording the current captured image; and to start and stop web broadcasting. 

You can use the Toolbar command on the View menu to change the size of the 

toolbar icons or to hide the toolbar. You can select small, large, or huge icons. If the 

toolbar is hidden, you can select an icon size to display the toolbar.  

 

Save a snapshot of the current image captured by the VGA2Ethernet user 

interface to a file on the video capture workstation. Select a location for the 

file and select a file format. You can save the snapshot as a Windows bitmap 
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(*.bmp), portable network graphics (*.png), or JPEG (*.jpg) file. 

 

Print a snapshot of the current image to the configured printer. 

 

Copy a snapshot of the current image to the video capture workstation 

clipboard. You can paste this image into a document or other application as a 

bitmap image. 

 

Start or stop recording the images being captured by the VGA2Ethernet user 

interface. When you start recording, the status bar displays RECORDING and 

also displays information about the image or video file being recorded. When 

you stop recording, the status bar displays information about the saved image 

files or video file. 

 

Pause or resume image capturing. If you select pause, the VGA2Ethernet 

user interface stops displaying captured images. Pause also pauses 

recording a video, saving image files, and web broadcasting. Select pause 

again to resume displaying captured images and resume recording or web 

broadcasting. 

 
Enable audio capture. 

 

Start or stop broadcasting or sharing captured images over the Internet. 

Status Bar 
 

 The status bar displays information about the VGA2Ethernet user interface: 

 The IP address of the device from which the VGA2Ethernet user interface is 

receiving captured images. 

 The location and file name of image or video files saved while recording.  

 The web broadcasting status. 

o SHARING OFF means web broadcasting is turned off. SHARING 

ON indicates that web broadcasting is turned on.  

 Recording status.  
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o RECORDING means that the VGA2Ethernet user interface is 

recording captured images.  

 The data rate is the rate (in MB/s, KB/s, Mbps, and Kbps) that the 

VGA2Ethernet user interface is receiving data from the device capturing 

images. 

 The frame rate that the VGA2Ethernet user interface is operating at in frames 

per second (fps).  

 The number of frames or images that the VGA2Ethernet user interface has 

displayed since the VGA2Ethernet user interface was last started. The 

number of frames is only visible if you select Number of captured frames on 

the status bar from the Display tab of the Options dialog. The number of 

frames stops incrementing and starts flashing if you have paused image 

capture. Use the Reset counter button to reset the number of frames from the 

Display tab of the Options dialog. 

 The VGA mode and refresh rate of the video source. 

 

Capture, Recording, and Display Options  

This section introduces the options available from the Tools menu when you select the 

Options command. These options control how the VGA2Ethernet user interface 

records images and audio, displays images, and shares or broadcasts images over 

the Internet. Note that this application is common to a number of different products. 

The KVM tab functionalities are not applied to the VGA2Ethernet product. 

 

Configuring Recording Options 

 

To control how the VGA2Ethernet user interface records captured images, select 

Options from the Tools menu and then select the Recording tab. You can record 

captured images as a series of consecutively saved graphic files or as a video file. 
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How the VGA2Ethernet user interface records images when you start recording from 

the Toolbar or the capture menu depends on how you set the recording options.  

Figure 11. The Recording tab of the Options window 

 

 

You can select the following options: 

Record as Specify whether video or images are 
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recorded 

Select Codec Select codec that is applied for 

compressing the signal 

AVI file size limit Specify the size limit of the .AVI file where 

the data is recorded to 

Automatically restart recording Select the checkbox to restart recording 

automatically. This checkbox enables the 

five fields below. 

Overwrite the same file (old content will 

be lost) 

After the video file size limit is reached, 

delete the original file and start recording a 

new video file with the same name. If you 

select this option the original saved video 

data is lost. 

Create a new file every time recording 

is restarted 

After the video file size limit is reached, start 

a new video file. You can use the append 

suffix setting to create a unique name for 

the new file or files. 

Append suffix…  When you start a video recording session 

you are prompted to enter a file name. If the 

file exceeds the AVI file size limit, the 

VGA2Ethernet user interface starts another 

file named with the original file name 

appended with a sequential numeric suffix. 

Use the append suffix options to specify the 

format of this suffix.  

 

Each suffix starts with a % and can include 

the following characters:  

02, 04, 06, or 08 indicates the number of 

digits to use in numbering the suffix. You 

can specify 2, 4, 6, or 8 digits. 

d means use decimal numbers in the suffix. 
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X means use hexadecimal numbers in the 

suffix. 

The suffix %02d means the saved file 

names would end with two-digit decimal 

numbers, for example: 01, 02, 03, ... 10, 11 

and so on. The suffix %04X means the 

saved file names would end with 4-digit 

hexadecimal numbers, for example: 0001, 

0002, 0003, ... 000A, 000B and so on. 

…starting with Enter the starting number used in the file 

name suffixes in decimal format. If the 

suffixes include hexadecimal numbering 

this decimal number is automatically 

converted to hexadecimal.  

 

For example, if you named the video file 

VID, set the suffix to %02d and set starting 

with to 1, the video file names would be 

VID.avi, VID01.avi, VID02.avi and so on. 

Overwrite existing files If you select overwrite existing files, files are 

saved according to the video file recording 

options. Existing files are replaced with the 

new files.  

 

If you do not select overwrite existing files, 

the file number in the suffix of the file name 

is incremented until a file can be saved 

without overwriting an already saved file. 

Automatically turn recording off Specify under what conditions recording 

turns off automatically 

After … frames have been saved Enter a number of frames 

After … elapsed Enter a number of time units elapsed 
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Configuring Display Options 

 

To change display options from the Tools menu, select Options and then select the 

Display tab.  

Figure 12. The Display tab of the Options window 
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The following display options are available: 

Display format Specify the format video or image are 

displayed in 

Image scaling Specify whether the image should be 

scaled and how 

Image rotation Specify whether the image should be 

rotated and how 

Resize window on resolution change Select the checkbox to resize window when 

the image resolution is changed 

Invert colors for printing Select the checkbox to change dark colors 

to light colors and light colors to dark colors 

Flip image vertically Flip the image at its vertical axis 

Select the check boxes below to add 

optional indicators to the status bar… 

 

Frame rate Displays frame rate 

Crop rectangle Displays crop status 

Audio format Displays audio format 

Number of captured frames Displays number of captured frames 

Data rate (network grabbers only) Displays data rate 
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Configuring Capture Options 

Use this tab to configure multiple capture options.  

 

Figure 13. The Capture tab of the Options window 

 
 

Enable hardware cropping Select the checkbox to enable cropping 
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functionality 

Left, Top, Width, Height Enter the values for the crop rectangle 

Force video mode detection Specify how often the application indicates 

the type of the video signal being received. 

Note that although frequent video mode 

detection decreases reaction time when 

changing video mode, it may reduce the 

frame rate. 

Automatically reconnect network 

grabbers 

Select the checkbox to restore connection 

with the remote frame grabbers in case the 

connection has been lost. Otherwise the 

system connects to the local frame grabber 

(if any) or displays a warning “No frame 

grabbers found”. In this case you need to 

restore connection manually. 

Limit frame rate to Setup maximum frame rate for the video 

signal 
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Setting On-Screen Text Parameters 

 

Using this tab you can timestamp the captured video and add some static text. 

Figure 14. The On-Screen Text tab of the Options window 
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Timestamp Select this checkbox to enable setting timestamp parameters 

Static text Select this checkbox to enable setting static text parameters 

Format Specify the timestamp format 

Color Set the color 

Font Set the font and the font size 

Position Set the position for the timestamp or text 

Outline Add an outline to the timestamp or text 
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Configure Audio Settings 

 

Use this tab to configure audio signal that is being captured. 

Figure 15. The Audio tab of the Options window 

 

Audio format Select the output audio format 

Audio source Select the audio source 

Play captured audio Select this checkbox to enable capturing and broadcasting 
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audio 

 

Configure Startup 

 

Use this tab to specify what actions the application should perform during startup. 

Figure 16. The Startup tab of the Options window 
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Start in full screen mode When the application starts, it resizes to 

the current resolution of the screen 

Search for network grabber at startup The application searches for a network 

grabber on your subnet if it does not find 

any local frame grabbers 
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4. Mac OS X VGA2Ethernet user interface 
This chapter describes common functions and features of the Epiphan VGA2Ethernet 

user interface for Mac OS X. You can use the Mac OS X version of the Epiphan 

VGA2Ethernet user interface to configure a VGA2Ethernet attached to the network 

and to record video captured by the VGA2Ethernet. 

This chapter assumes that VGA2Ethernet has been properly installed. To start using 

this chapter you should have:  

- Selected a video capture workstation running Mac OS X.  

- Successfully installed the Epiphan device drivers and application on the 

video capture workstation. 

- Connected the VGA2Ethernet device. 

Upgrading to the Latest Mac OS X Software Version  

From time to time Epiphan makes new versions of all Epiphan frame grabber software 

available from the Epiphan web site. In most cases you can upgrade the Epiphan 

software on your Mac OS X video capture workstation by using normal procedures to 

download the latest version and install it without uninstalling the previous version.  

Note: Some versions of the VGA2Ethernet user interface do not install a shortcut on 

the Mac OS X desktop. You can drag the Epiphan icon from the Applications folder to 

your desktop or add it to the Dock after installing a new version of the VGA2Ethernet 

user interface. You may also need to delete older versions of the Epiphan icon.  

 

Finding Software Updates  

To find the latest versions of all Epiphan software for Mac OS X, go to 

http://www.epiphan.com/downloads. You can also browse to the download page for 

the Epiphan product you are using. For example, if you own an Epiphan 

VGA2Ethernet device, you can browse to http://www.epiphan.com and select 

Products > VGA2USB Frame Grabbers > VGA2Ethernet > Download.  

http://www.epiphan.com/downloads/
http://www.epiphan.com/
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On these download pages you will find the most recent version of this VGA2Ethernet 

User Guide and the most recent release of the Epiphan device driver, QuickTime 

component and VGA2Ethernet application compatible with MacOS X.  

Starting the Mac OS X VGA2Ethernet user interface  

Before starting the VGA2Ethernet user interface the device must be connected to the 

same network as the video capture workstation. The device should also be connected 

to power.  

Start the VGA2Ethernet user interface as you would any other application installed on 

the video capture workstation.  

As the application starts the message Capture Device not Found appears on the 

VGA2Ethernet user interface window.  

1. Select Open Network Grabber from the File menu. 

2. Select the arrow beside the Network Address box to open the list of 

networked devices. 

3. Select a device and select connect. 

The following messages may appear in the capture window.  

 Detecting Video Mode as the VGA2Ethernet user interface starts up and 

attempts to connect with the frame grabber. 

 Tuning Capture Parameters if the VGA2Ethernet user interface finds the 

frame grabber and begins synchronizing and tuning capture settings and 

image adjustments  

 No Signal Detected if the VGA2Ethernet user interface cannot connect with 

the frame grabber or if the frame grabber is not connected to an active video 

source. 
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If you have added a viewer password, you will be prompted to enter the password 

before the image being captured by the device appears in the capture window.  

Figure 17. VGA2Ethernet user interface window (Mac OS X) 

 

If the VGA2Ethernet user interface successfully connects to and synchronizes with the 

frame grabber, the VGA2Ethernet user interface window begins displaying captured 

images. 

Title Bar Displays the Epiphan product name, screen resolution and 

refresh rate of the video source. 

Toolbar Switch to full screen mode, override image adjustments, and 

display information about the frame grabber. 

Captured Image The image currently being captured by the device. 
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Menus 

This section describes the commands available from the VGA2Ethernet user interface 

menus for Mac OS X. 

 

 

File Menu  

Use the File menu commands to save and print the current image displayed by the 

VGA2Ethernet user interface.  

New Capture Window Open another capture window. The window opens 

displaying the same image as the original window. You 

can open a different device in each capture window. 

Having a large number of Capture Windows open 

simultaneously can eventually slow performance on the 

video capture workstation. 

Open Network Grabber Connect to a VGA2Ethernet device connected to the 

network. You can enter the IP address for the device if 

you have it, or you can click on the triangle and select 

from the list of devices found on the network. 

Recent Network Grabbers Select from the list of recently opened VGA2Ethernet 

devices. The devices will be listed by IP Address and 

device serial number. Select Clear Menu to remove all 

entries on the list of devices. 

Disconnect Network 

Grabber 

Disconnect the VGA2Ethernet user interface from a 

VGA2Ethernet device. The device serial number will be 

shown next to the Disconnect menu item. If you have 

multiple capture windows open, make sure you select 

the capture window containing the device you want to 

disconnect. 
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Record Movie Record captured video in a file 

Save Image Save a snapshot of the current image to a file on the 

video capture workstation. Select a name and a location 

for the file and select a file format. You can save the 

snapshot as a bitmap (*.bmp), portable network 

graphics (*.png), JPEG (*.jpg) file, or tiff (*.tiff) file. 

Page Setup Configure the printer settings used when you select the 

Print command or the Print toolbar button. 

Print Print a snapshot of the current image to the configured 

printer. 

 

Edit Menu  

From the edit menu you can copy a snapshot of the current image.  

Copy Copy a snapshot of the current image to the video 

capture workstation clipboard. You can paste this image 

into a document or other application as a bitmap image. 

 

 

View Menu  

Use the commands on the view menu to control the parts of the VGA2Ethernet user 

interface window that are displayed.  

Show/Hide Device List Open or close a drawer on the side of the capture 

window showing a list of the Frame Grabbers connected 

to the video capture workstation. Each list entry includes 

a thumbnail of the image in the capture window, the 

name, and serial number of the device, and the screen 

resolution and refresh rate of the video source. You can 

use the list to switch between devices displaying 

captured images in the capture window. 
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Show/Hide Device 

Information 

Enable or disable displaying information about the 

current Frame Grabber at the top of the VGA2Ethernet 

user interface window. The display shows the hardware 

type, location (IP Address), serial number, video mode, 

frame rate and data rate of the device. 

Show/Hide adjustment 

Controls 

Override image adjustments. When the VGA2Ethernet 

user interface first starts, the application and the Frame 

Grabber adjust the captured image for optimal 

appearance. However, you may need to override these 

image adjustment settings to improve the image quality. 

Enter Full Screen Scale the VGA2Ethernet user interface window to fill the 

screen. Press Command-F to exit full screen mode. 

Hide/Show Toolbar Enable or disable displaying the toolbar at the top of the 

VGA2Ethernet user interface. 

 

 

Tools Menu  

Use the commands on the Tools menu to show VGA Mode Information and to upload 

or save an EDID file.  

Show VGA Mode 

Information 

Display low level information about the Frame Grabber 

VGA mode. When requested, you can use this 

command and copy this information into an email to 

send to Epiphan Support. 

Upload EDID To Device Upload an extended display identification file to the 

device. 

Read EDID From Device Save a copy of the device extended display 

identification file to the video capture workstation. 

 Other commands are not applicable to VGA2Ethernet 
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Toolbar  

Use the toolbar to save, copy or print the current captured image, to override image 

adjustments, and to show information about the device.  

 

Save 

 

Save As Enter the file name for saving data 

Where Enter the path where the file is saved 

Format Select the format for the recorded file 
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Copy 

Use this command to copy the snapshot of the image to buffer. 

Print 

Use this command to specify printing settings and print the image. 

 

 

Record 

 

Click this button to start recording of the captured video. 
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Adjust 

 

Configure horizontal/vertical shift to offset the captured image position. Select the 

checkboxes to adjust shifting automatically. 
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Info 

 

Click this button to display information about the frame grabber, its location, serial 

number and image characteristics. 
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Devices 

Click this button to display all frame grabber devices that are currently available in 

network. 

 

 

 

Changing System Preferences  

Before starting to record videos or to save or print images, you should configure 

Epiphan QuickTime integration options by opening System Preferences, selecting 

VGA2USB under Other, and configuring QuickTime settings.  

You can also select About to view information about the current software and driver 

versions.  
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5. Web admin interface 
 

This chapter describes configuring the Web admin interface options.  

Logging into the Web admin interface  

Use the Web admin interface to configure the VGA2Ethernet device. You can log 

into the Web admin interface by:  

 Selecting Web Config from the Epiphan Network Discovery Utility (Windows 

XP, Vista and 7 only).  

 Browsing to the VGA2Ethernet admin interface using any web browser. The 

web browser can be running on Windows or Mac OS X.  

 

Note: You can always log into the Web admin interface by browsing to the default 

VGA2Ethernet IP address, which is http://192.168.255.250. To log into a device using 

this IP address you must change the IP Address of the video capture workstation to 

the static IP address 192.168.255.249 and netmask 255.255.255.252. Then open a 

Web browser and browse to: 

http://192.168.255.250/admin 

Disconnect any other Epiphan devices from the network before attempting to connect 

to the VGA2Ethernet device.   Restore the original network settings for your 

workstation. 

To log into the Web admin interface from the Network Discovery 

Utility  

1. Start the Epiphan Network Discovery Utility and select Search to find the 

Epiphan devices on the network.  

2. Select the VGA2Ethernet device and select Web config. You can log into any 

device with a status of Device OK. A web browser starts and you are 

prompted for a user name and password.  

3. Enter the following (assuming the admin password has not yet been 

http://192.168.255.250/
http://192.168.255.250/
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configured):  

User Name: admin  

Password: (no password required)  

4. To add a Web admin interface password, see “Adding or Changing the Web 

admin interface Password”.  

5. Press Enter. The Web admin interface opens.  

 

To log into the Web admin interface using a web browser  

Note: The web browser can be running on Windows or Mac OS X.  

1. Start a web browser on any workstation connected to the same network as 

the VGA2Ethernet device.  

2. Browse to:  

http://<VGA2Ethernet_IP_address>/admin  

For example, if the VGA2Ethernet IP address is 192.30.23.45 browse to:  

http://192.30.23.45/admin  

Remember to include “/admin” at the end of the address or you will access 

the broadcast rather than the Web admin interface.  

3. Enter the following:  

User Name: admin  

Password: (no password required, if it is the initial 

factory default setting)  

To add a Web admin interface password, see “Adding or Changing the Web 

admin interface Password”. 

4. Press Enter. The Web admin interface opens.  
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Figure 18. VGA2Ethernet Web admin interface 

 
Use the Web admin interface configuration options to administer and operate the 

VGA2Ethernet device.  

 

Admin Access  Change the admin account password. See Adding or Changing the 

Web admin interface Password.  

Viewer Access  Change the viewer account password. See Adding or Changing the 

Viewer Password.  

Network Change the VGA2Ethernet network configuration. See Changing 

the Network Configuration. 

Frame Grabber  Make Frame Grabber image adjustments. See Configuring Frame 

Grabber Adjustments.  

Remote 

Support 

Enable and configure remote support. See Configuring Remote 

Support. 

Date and Time  Change VGA2Ethernet date and time settings. See Setting the Date 
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and Time.  

Firmware 

Upgrade  

 Upgrade the VGA2Ethernet firmware. See Upgrading the 

VGA2Ethernet Firmware. 

Maintenance Reboot or shutdown the VGA2Ethernet device. 

Restore factory configuration. See Using Maintenance Controls. 

Start and stop frame grabber. 

System 

Description 

Specify the VGA2Ethernet device’s name. It is displayed in a list of 

available devices in Network Discovery Utility under this name. 

Info Display information about the VGA2Ethernet Firmware, CPU, 

Frame Grabber and VGA Mode. See Displaying VGA2Ethernet 

Information. 

 

 

Configuring the Ethernet Bridge For Use if You Have 
Only One Ethernet Connection  

In some cases you may only have one network connection available for both the video 

capture workstation and the VGA2Ethernet device. To record captured images and 

still connect both the video capture workstation and the VGA2Ethernet device to the 

network you can do the following:  

1. Log into the Web admin interface. 

2. In the Network section, select the Enable Ethernet Bridge checkbox. 

3. Scroll down the Web admin interface to the Reboot the system section and 

select Reboot. Then select Continue. 

It takes a few minutes for the device to reboot.  

4. Connect Eth 1 directly to the video capture workstation using a cross-over or 

regular Ethernet cable. 

5. Connect Eth 2 to the network. 
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Figure 19. Connecting network and a PC to VGA2Ethernet  

 

In this configuration the Eth 1 and Eth 2 interfaces act like a 2-port hub allowing the 

video capture workstation to connect to the network.  

For best performance you should connect the video capture workstation to Eth 1 and 

the Ethernet network to Eth 2. Also, the overhead required to forward packets 

between Eth 1 and Eth 2 can affect the video capture performance of the device. You 

can temporarily improve performance by disconnecting Eth 2 from the network.  

 

 

 

If the Network Does Not Have a DHCP Server  

 

If the network does not have a DHCP server, you need to log into the Web admin 

interface to change the VGA2Ethernet IP address. To do this, you need to temporarily 
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change the network configuration of the workstation.  

You must also establish an Ethernet connection between the VGA2Ethernet device 

and your workstation. You can do this using one of the following methods:  

 Connect the VGA2Ethernet Eth port to the same Ethernet network as the 

workstation.  

 Connect the VGA2Ethernet Eth port to an Ethernet network switch and 

connect the workstation’s Eth port to the same switch.  

 Connect the VGA2Ethernet Eth port directly to the workstation’s Eth port. 

(You can use a regular or crossover Ethernet cable for this connection.)  

 

To log into the Web admin interface  

1. Record the network settings for the workstation so that you can restore them 

later. 

2. Change the IP address of the workstation to static IP assignment with the 

following  

Address: 192.168.255.249  

Subnet Mask: 255.255.255.252  

3. Follow the instructions for your operating system. If the operating system 

supports adding more than one IP address, then you can add this IP 

address as a second IP address instead of changing the current address.  

4. Start a web browser on the workstation and browse to: 

http://192.168.255.250/admin/  

5. Enter the following:  

User Name: admin  

Password: (no password required)  

6. Press Enter. The Web admin interface opens. To change the VGA2Ethernet 

IP address, see “Changing the Network Configuration”.  

7. Don’t forget to restore the previous network system on your workstation once 

you have completed your administration of VGA2Ethernet. 
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Adding or Changing the Web admin Interface 
Password  

Initial factory settings are such that no password is set in the Web admin 

interface. For security reasons, you should add a password to control access to 

the administration interface functions. You can add a password or change the 

password at any time.  

Note: If you lose or forget the admin password you should contact your 

reseller or Epiphan Technical Support for help to reset the device to factory 

defaults.  

To add a password to the Web admin interface  

1. Log into the Web admin interface. 

2. Select Admin Access. 

3. Enter and repeat the new password. The password is case sensitive and can 

include up to 255 ASCII characters. 

4. Select Apply. The password changes and after a pause you are prompted to 

log into the Web admin interface. 

5. Log into the Web admin interface with the admin user name and the new 

password. 

Figure 20. Change Administrator’s Password 

 

 

To delete the Web admin interface password  
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You can delete the Web admin interface password if you don’t want to require 

administrators to enter a password to log into the Web admin interface.  

Note: Removing the Web admin interface password makes it easier for 

unauthorized users to change the VGA2Ethernet configuration.  

1. Log into the Web admin interface.  

2. Select Admin Access. The password fields should be blank.  

3. Select Apply without adding characters to the password fields. The password 

is deleted and after a pause you can log into the Web admin interface with 

the user name admin and no password.  

Adding or Changing the Viewer Password  

Add a password to control viewer access to the broadcast. You can add a viewer 

password or change the viewer password at any time.  

Note: If you lose or forget the viewer password you replace it with a new password 

at any time.  

To add or change the viewer password  

1. Log into the Web admin interface.  

2. Select Viewer Access.  

3. Enter and repeat the new password. The password is case sensitive and can 

include up to 255 ASCII characters.  

4. Select Apply. The password changes and you must log into the Web admin 

interface.  

5. Log into the Web admin interface with the admin user name and password.  

6. Distribute or communicate the viewer access password to authorized viewers 

of the broadcast. 

Notes:  

 The viewer access password is the same for all viewers until it is changed. 

Any viewer that knows the password will continue to have access until the 
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password is changed. 

 It is good practice to change the password each time there is a change in the 

users that should be authorized to access the broadcast. 

 Please contact your network security administrator with respect to password 

management required for your applications. 

Figure 21. Change Viewer's Password 

 

 

 

To delete a viewer password  

You can delete the viewer password if you do not want to require viewers to enter a 

password to access the broadcast.  

1. Log into the Web admin interface.  

2. Select Viewer Access. The password fields should be blank.  

3. Select Apply without adding characters to the password fields. The password 

is deleted.  

 

Configuring Frame Grabber Adjustments  

A frame grabber is an electronic device that captures individual still frames from an 

analog video signal or a digital video stream and transmits them in a digital form. An 

Epiphan frame grabber is used as a component in the VGA2Ethernet device and can 

be configured separately.   
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On the Web admin interface, select Frame Grabber to configure frame grabber 

adjustments. The VGA2Ethernet device automatically adjusts image capture settings 

every time it starts up. The automatic image adjustment is repeated every 60 seconds 

during operation. You can change the interval between automatic adjustments if you 

want them to occur more or less often. The capture settings attempt to produce the 

best quality captured image for the equipment used in your applications.  

Normally you would not have to make manual image adjustments. However, you may 

have special requirements or for other reasons have image quality problems that may 

only be fixed by making image adjustments.  

The Web admin interface contains most of the information that you need to make 

image adjustments including a brief description of the effect of each adjustment and 

the adjustment range.  

- To make an adjustment, add a value to one or more fields and select 

Apply.  

- To clear any adjustments, delete the value from one or more fields and select 

Apply. To have changes take effect, you must reboot the VGA2Ethernet 

device (see “Rebooting or Restarting VGA2Ethernet”). You can make more 

than one change before selecting Apply and rebooting.  
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Figure 22. VGA2Ethernet Frame Grabber Adjustments 

 

 

Note: Because frame grabber adjustments are made automatically there are no 

default frame grabber adjustment settings.  
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Interval between 

VGA signal auto 

adjustments, sec 

Change the interval between automatic adjustments if you want 

them to occur more or less often. To suspend automatic 

adjustments, enter 0. 

Vertical shift Configure vertical shift to offset the captured image position. For 

example, a captured image shifted slightly downward (vertically) 

can be corrected with minor adjustments to the vertical shift 

settings.  

Increasing or decreasing the value entered in the Vertical Shift 

field shifts the image up or down. 

Horizontal shift Configure horizontal shift to offset the captured image position. 

For example, a captured image shifted slightly to the right 

(horizontally) can be corrected with minor adjustments to the 

horizontal shift settings.  

Increasing or decreasing the value entered in the Horizontal Shift 

field shifts the image to the right or left. 

Phase Configure phase (also called sampling phase) to adjust the 

horizontal resolution of the image. Improperly adjusted phase will 

result in a fuzzy image. You can adjust the sampling phase in 

small steps until a sharper image is displayed. 

PLL adjustment Configure PLL to adjust the vertical synchronization properties of 

the image. The PLL adjustment may need to be changed when 

there is a repetitive distortion or blurriness on the horizontal axis 

of the image. You can adjust the PLL setting in small steps until a 

sharper image is displayed. 

Offset Use the offset and gain controls together to optimize image 

quality. Increasing offset reduces background noise but also 

reduces the overall signal.  

Balance offset and gain to achieve the best quality image. You 

should adjust these settings by the smallest values possible to 
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achieve the best results. You can compensate for a large change 

to one by making a large change to the other, but setting both 

offset and gain to high values can result in poorer video quality. 

Gain Use the offset and gain controls together to optimize image 

quality. Increasing gain amplifies weak signals but also increases 

noise. Balance offset and gain to achieve the best quality image. 

You should adjust these settings by the smallest values possible 

to achieve the best results. You can compensate for a large 

change to one by making a large change to the other, but setting 

both offset and gain to high values can result in poorer video 

quality. 

Aspect ratio Set the aspect ratio of the captured image. The default aspect 

ratio is 4:3. You can change the aspect ratio to wide mode so that 

the VGA2Ethernet device can accurately capture wide aspect 

ratio modes.  

It's not always possible for the Epiphan device driver to 

distinguish between video modes when they have the same 

number of rows, for example, 1024x768 and 1280x768. You can 

change the aspect ratio to Wide Mode if you want the driver to 

choose wide video mode in these situations. 

Noise filter This setting allows you to get good noise performance 

Select EDID file Browse to the Extended display identification data (EDID) file to 

upload it. It describes the capabilities of the digital display to a 

video source. 

 

Changing the Network Configuration  
You may want to change the VGA2Ethernet network configuration:  

 If the network does not have a DHCP server.  

 If the network does have a DHCP server but you want the VGA2Ethernet 

device to have a static IP address.  
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 If the VGA2Ethernet device is using the DHCP server-assigned IP address, 

but you want to change the IP address. If for some reason the DHCP server 

goes down you can log into the VGA2Ethernet Web admin interface and 

change the IP address.  

 If you have previously configured the VGA2Ethernet device to use a static IP 

address and want to change some network settings or revert back to using 

DHCP.  

 

For network changes to take effect you must reboot the VGA2Ethernet device after 

making the changes. See “Rebooting or Restarting VGA2Ethernet”.  

Note: If you change the IP address you will need to remove the VGA2Ethernet device 

from the Network Discovery Utility and then select Search to find it again.  

Note: You can also see the VGA2Ethernet MAC address on the Network page.   

Providing the MAC address to your network administrator may be helpful for managing 

your network. 

To set the VGA2Ethernet to use a static IP address  

1. Log into the Web admin interface.  

2. Select Network.  

3. Select Use static address.  

4. Enter an IP Address, Network Mask, Default Gateway, and DNS Server that 

are valid for your network. Note: Clarify that this gateway setting is the 

gateway of your local LAN (i.e. local router). Contact your network 

administrator if you are not sure what information to use. The IP address, 

Network Mask, Default Gateway, and DNS Server that you assign must be 

compatible with your network.  
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Figure 23. Change the VGA2Ethernet IP address 

 

For example:  

IP:  192.168.1.20 

Mask:   255.255.255.0 

Gateway:  192.168.1.2 

DNS server:  192.168.1.99 

1. Select Apply to save these changes. 

2. Select Maintenance. 
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3. Select Reboot Now.  

4. It takes a few minutes for the VGA2Ethernet device to reboot.  

5. After a few minutes log into the Web admin interface by browsing to its new 

IP address. For the example above, browse to: http://192.168.1.20/admin/ 

6. Enter the Web admin interface user name and password to login.  

 

 

To reset network settings to use DHCP  

By default, if you connect the VGA2Ethernet device to a network with a DHCP server, 

the DHCP server will automatically configure the network settings. If required you can 

disable DHCP settings and use a static IP address. This procedure describes how to 

re-enable DHCP settings that have been disabled.  

 
1. Log into the Web admin interface.  

2. Select Network.  

3. Select Use DHCP. 

4. Select Apply to save these changes.  

5. Select Maintenance.  

6. Select Reboot Now. It takes a few minutes for the VGA2Ethernet device to 

reboot.  

7. After a few minutes log into the Web admin interface by browsing to its new 

IP address. For example, browse to: http://192.168.23.107/admin/  

8. Enter the Web admin interface user name and password to login.  

  

http://192.168.1.20/admin/
http://192.168.23.107/admin/
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Configuring Remote Support  

The VGA2Ethernet device uses remote support settings to communicate with the 

Epiphan maintenance server. When enabled, communicating with the maintenance 

server allows Epiphan to review the device configuration, firmware version, and other 

basic operating parameters. If the VGA2Ethernet device is having problems and you 

contact Epiphan Support, the support team can use this maintenance information to 

help remotely troubleshoot the problems.  

Note: The VGA2Ethernet device does not send private information to the Epiphan 

maintenance server, just basic operation and configuration information. The amount 

of traffic sent to the Epiphan maintenance server is small and should not affect the 

network or Internet throughput.  

By default, communication with the Epiphan maintenance server uses TCP port 30. 

The default address of the Epiphan maintenance server is epiphany.epiphan.com. The 

VGA2Ethernet device must be able to find a DNS server to resolve the default 

address and then must be able to connect to this address on the Internet using TCP 

port 30. If the VGA2Ethernet network settings are set to use DHCP, it gets the 

address of the DNS server from the DHCP server. If network settings are set to use a 

static IP address, you must enter the IP address of the DNS server. You can get this 

IP address from your network administrator.  

If you have a firewall or some other device protecting the network from the Internet 

and you would like to enable remote support, the configuration of this device may 

have to be changed for the VGA2Ethernet device to connect to the Epiphan 

maintenance server. Contact your network administrator for assistance.  

Use the Remote Support section in the Web admin interface to access the settings: 
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Figure 24. Remote Support Configuration 

 
 

You can change the following remote support settings. Remote support is enabled by 

default. 

Enable remote 

support  

Allow Epiphan Support to log into the VGA2Ethernet device with 

special access privileges to troubleshoot problems.  

Enable 

connection to 

maintenance 

server  

The VGA2Ethernet device establishes an outgoing TCP connection 

to the Epiphan maintenance server using TCP port 30. Using this 

connection, the device sends information to the Epiphan 

maintenance server and Epiphan Support can use this connection 

to remotely log into the device.  

Server Address  

The address of the Epiphan maintenance server. This address is 

usually epiphany.epiphan.com. However, you can change this 

address if required, (but usually only as recommended by Epiphan 

Support). For example, you may have to change this address to a 

numeric IP address if your VGA2Ethernet device cannot connect to 

a DNS server.  

Server Port The Epiphan maintenance server’s port. 
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You can enable and disable remote support and the connection to the maintenance 

server independently.  

The following table describes the results of different configurations:  

Enable 

Remote 

Support 

Enable 

Connection to 

Maintenance 

Server 

Result 

Yes Yes The VGA2Ethernet device connects to the Epiphan 

maintenance server. If required, Epiphan Support can 

remotely connect to the device with special access 

privileges.  

No Yes The VGA2Ethernet device connects to the Epiphan 

maintenance server. Epiphan Support can remotely 

connect to the Web admin interface with the same 

access privileges as an administrator.  

Yes No The VGA2Ethernet device does not connect to the 

Epiphan maintenance server. If required, Epiphan 

Support can remotely connect to the device with special 

access privileges. If you provide remote access to your 

network in some other way (for example, using port 

forwarding). Contact Epiphan Support for assistance.  

 

Please contact your network security administrator to review your security settings for 

VGA2Ethernet. 

 

Setting the Date and Time  

You can set date and time manually or you can enable Time synchronization. Enable 

Time Synchronization to update the date and time by using a time server. You can 
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select NTP, to get date and time updates from a public network time protocol (NTP) 

server by connecting to the server over the Internet. NTP uses UDP port 123. The 

default NTP server is time.nrc.ca. You should change this to an NTP server 

recommended for your location (available from your network administrator).  

 

Figure 25. Date and Time Configuration 

 
 
 
 

Time Zone Select the appropriate time zone 

Enable time 

synchronization 

This parameter enables time synchronization with the 

defined server 
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Protocol Select the time protocol 

Server IP 

Address 

Enter the IP address of the time server 

Update interval Specify frequency of time synchronization 

Set time 

manually 

This parameter enables manual time setting 

Date (yyyy-mm-

dd) 

Specify the date 

Time (hh:mm:ss) Specify the time 

RTC calibration: 

(-31..+31). 

This field allows RTC calibration – slowing or speeding the 

clock up to 10 sec/day. 

 

For complete information about NTP including a list of recommended NTP 

servers, see The NTP Public Services Project. To make sure you get the correct 

time from an NTP server you should select the correct Time Zone for the 

location of your VGA2Ethernet device.  

If the VGA2Ethernet device cannot connect to the Internet and if there is an 

RDATE server on the network, you can set time synchronization to use  

RDATE (defined by RFC 868). Contact your network administrator for the 

address of the RDATE server and enter the RDATE server IP address into the 

Server IP Address field.  

In both cases, you can control how often the date and time are updated. The 

Time Update interval can be every 1, 6, 12, or 24 hours.  

 

 

Upgrading the VGA2Ethernet Firmware  
You can obtain new firmware versions from Epiphan Support. New firmware is 

http://support.ntp.org/bin/view/Main/WebHome
http://www.faqs.org/rfcs/rfc868.html
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released to fix known problems or to add new features.  

Figure 26. VGA2Ethernet firmware upgrade 

 
 
Installing new firmware can take several minutes. Once you start a firmware upgrade, 

the VGA2Ethernet device cannot display captured images until the firmware upgrade 

is complete.  

Note: Do not interrupt or power down the VGA2Ethernet device during the firmware 

update.  

 

To install new firmware: 

 

1. Get the new firmware file from Epiphan Support.  

2. Place a copy of the firmware file on the workstation you use to connect to the 

Web admin interface.  

3. Log into the Web admin interface.  

4. Select Firmware Upgrade.  

5. Select Browse and then select the firmware file.  

6. Select Apply. The firmware uploads to the VGA2Ethernet device. The device 

unpacks the firmware update file, verifies the contents and then upgrades the 

firmware.  

7. To complete the firmware upgrade you must reboot the VGA2Ethernet 

device. See Rebooting or Restarting VGA2Ethernet.  

8. Log into the Web admin interface and confirm that the VGA2Ethernet device 

is running the new firmware version by selecting Info and viewing the 

firmware version.  
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Note: In case firmware update fails you can restore the factory configuration as it is 

explained in the following section (“Using Maintenance Controls”). 

 

Using Maintenance Controls  

On the Web admin interface, select Maintenance to perform operations such as 

restoring the factory configuration, and rebooting or shutting down the device.  

Figure 27. Maintenance Options 

 

Restoring the VGA2Ethernet Default Factory 
Configuration  

Select Restore beside Restore Factory Configuration to reset the Broadcasting and 

Frame Grabber settings. The factory default configuration is the configuration that the 

VGA2Ethernet device had when you received it from Epiphan. It can be useful to 

return the VGA2Ethernet device to this configuration if you have made a number of 

configuration changes that you want to reverse.  

Restoring the factory configuration can also help with troubleshooting. If after making 

a number of configuration changes you notice problems and you are not sure which 

change is causing the problems, you can restore the Factory Configuration and start 

over.  
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Rebooting or Restarting VGA2Ethernet 

Many VGA2Ethernet configuration changes require you to reboot the 

VGA2Ethernet device. For an example, see “Changing the Network 

Configuration”.  

To reboot or restart the VGA2Ethernet 

1. Log into the Web admin interface.  

2. Select Maintenance.  

3. Beside Reboot select Reboot now.  

The VGA2Ethernet device takes a short time to reboot and resume operation.  

 

Shutting Down the VGA2Ethernet Device  

Shut down VGA2Ethernet to take the device off the network without disconnecting the 

power.  

To shut down the VGA2Ethernet device 

 

1. Log into the Web admin interface. 

2. Select Maintenance. 

3. Beside Shut down select Shutdown now.  

 

The VGA2Ethernet device shuts down. Now you cannot log into the Web admin 

interface or view captured images. At the same time the Network Discovery Utility will 

not find the VGA2Ethernet device on the network. To restart the VGA2Ethernet device 

you must disconnect and reconnect the power. 

Displaying VGA2Ethernet Information  
Select Info on the Web admin interface to display the following VGA2Ethernet 

system information:  
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 The current firmware version including the version number and details of the 

firmware build.  

 The VGA2Ethernet system CPU details.  

 The number of the Frame Grabber installed in the VGA2Ethernet device.  

 The Frame Grabber VGA mode information.  

 

This information is also displayed when you first log into the Web admin interface.  
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Figure 28. VGA2Ethernet system information 
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6. Web Broadcasting 

You can use the information in this chapter for internet sharing or broadcasting of the 

images captured by your VGA2Ethernet device. Captured images are sent to the 

Epiphan web broadcasting portal through the VGA2Ethernet user interface. Each web 

broadcast session is labeled with the serial number of the VGA2Ethernet device that is 

sending images. The device serial number appears on the VGA2Ethernet user 

interface title bar.  

Note: Web Broadcasting is intended as a demonstration only and has a 10-hour time 

limit.  

Before you can begin web broadcasting you must:  

 Follow the steps in Installing the Drivers and Application for 

Windows to download and install the VGA2Ethernet device driver  

 Connect your VGA2Ethernet device as described in Connect and Power 

on a VGA2Ethernet Device.  

Setting the Display Format for Web Broadcasting  

Before starting web broadcasting you must set the display format to RGB 24 bits per 

pixel.  

To set the Display format for web broadcasting  

1. Open the VGA2Ethernet user interface. 

2. From the Tools menu select Options. 

3. Select the Display tab. 

4. Set Display Format to RGB 24 bits per pixel. 

5. Optionally limit the frame rate to reduce the number of images sent over the 

Internet. This value will affect the amount of bandwidth used. 
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6. Depending on your requirements you may not have to change any other 

display settings. See Configuring Display Options. 

7. Select OK to save your changes. 

 

Starting a Web Broadcasting Session  
 

No special setup is required for web broadcasting except that the video capture 

workstation must be able to connect to the Internet. The video capture workstation can 

be connected directly to the Internet or to a LAN that is connected to the Internet.  

 

The following procedure is the same whether or not Epiphan has permanently enabled 

web broadcasting for your Frame Grabber.  

 

To start a web broadcasting session  

 

1. Start the VGA2Ethernet user interface. 

2. Select Web Broadcasting from the Tools menu. The Start web broadcasting 

dialog appears.  

Note the Internet address from which users can view the web broadcast. 

The Internet address is always http://www.vga2Ethernet.com/ followed by the serial 

number of the VGA2Ethernet device. The serial number is visible in the VGA2Ethernet 

user interface title bar. The web broadcast internet address is not displayed on the 

VGA2Ethernet user interface during the broadcast.  

3. Select Start Web Broadcasting. 

 

As images are captured by the VGA2Ethernet device they are broadcast over the 

Internet. The Status bar displays SHARING ON.  

Users can use a compatible web browser to connect to the Internet address to view 

the broadcast. See Viewing a Web Broadcasting Session for more information about 

the system requirements for viewing web broadcasts.  
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You can pause web broadcasting by selecting Pause from the Capture menu. You can 

stop web broadcasting by selecting Stop Web Broadcasting from the Tools menu. 

When you stop web broadcasting the status bar displays SHARING OFF. 

 

Viewing a Web Broadcasting Session  
 

You can view a web broadcasting session from any web browser on any computer 

(Windows PC, Mac OS X) that can connect to the Internet. The PC and web browser 

should be running the most recent version of Java. You can download the latest 

version of Java from http://www.java.com.  

 

To view a web broadcast, open a web browser and browse to the required Internet 

address, for example: http://www.vga2usb.com/V2U15100. The broadcast is not 

encrypted.  

 

A second web browser window appears displaying the message Applet is loading. 

Please wait… The broadcasted image should appear within 10 to 20 seconds.  

 

The first web browser window (in which the web broadcast address was entered) 

displays a message indicating that the web presentation has been opened in a new 

window. You can also use the first window to refresh the broadcast or re-open the 

broadcast window if it is accidentally closed. 

 

Troubleshooting Web Broadcasting Performance  

Three typical reasons for adjusting web broadcasting compression are:  

If the video capture workstation CPU usage is too high during web broadcasts or if 

receivers of the web broadcasts notice delays that you determine are caused by high 

CPU usage on the video capture workstation, you can decrease lossless 

compression. High CPU usage on the video capture workstation can result in the 

video capture workstation not being able to process all image data.  

http://www.vga2usb.com/V2U15100
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Note: You cannot change web broadcasting compression during a web broadcast. 

You must stop the broadcast, adjust the settings and then start the broadcast again.  

 

Changes made to default web broadcast compression settings are only visible to 

viewers of the web broadcast. Changing these settings does not change how the 

VGA2Ethernet device or the VGA2Ethernet user interface displays, records, or prints 

captured images.  

 

You can also improve the performance of web broadcasting by lowering the frame 

rate. Lowering the frame rate reduces the amount of Internet bandwidth used by 

reducing the number of frames broadcast. Lowering the frame rate also reduces the 

demand on the video capture workstation CPU resources because fewer frames 

means the video capture workstation uses fewer CPU resources to capture and 

compress the frames.  

 

To lower the frame rate, from the Tools menu select Options and then select Capture. 

Select Limit frame rate to and set the frame rate to a lower value. 

 

 

 

7. Windows Network Discovery Utility  
This chapter describes the functions and features of the Epiphan Windows Network 

Discovery Utility. The Windows Network Discovery Utility is installed on a Windows 

2000, XP, Vista or 7 video capture workstation during installing the VGA2Ethernet 

drivers and application. You can use the Network Discovery Utility to find and connect 

to the VGA2Ethernet devices, connected to the same network as the video capture 

workstation. You can also connect to a device’s Web admin interface by selecting 

Web config from the Network Discovery Utility.  
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Once you connect to a VGA2Ethernet device with the Network Discovery Utility you 

can use video capture software installed on the video capture workstation to record 

images captured by the VGA2Ethernet device.  

 

You can view captured images from within the Network Discovery Utility. However, 

you must install a third-party DirectShow compatible application on the same PC to 

record captured images.  

 

Note: The VGA2Ethernet drivers and application must be installed on the video 

capture workstation and you must have run the Network Discovery Utility and 

successfully found a VGA2Ethernet device to be able to view and record images using 

DirectShow-compatible software installed on the video capture workstation. 

 

Finding and Installing Drivers and Application 
Updates  

 

Find the latest VGA2Ethernet drivers and application on the VGA2Ethernet download 

page:  

 

http://www.epiphan.com/products/frame-grabbers/vga2ethernet/download/  

 

On these pages you will find the most recent versions of VGA2Ethernet 

documentation, VGA2Ethernet firmware that you can install on the VGA2Ethernet 

device), VGA2Ethernet drivers and application software which includes the Network 

Discovery Utility. 

 

Starting the Network Discovery Utility 

 

Start the Network Discovery Utility from the Windows Start menu by selecting Start > 

Epiphan VGA2Ethernet > VGA2Ethernet DirectShow Configuration Utiltity.  

http://www.epiphan.com/products/frame-grabbers/vga2ethernet/download/
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The Network Discovery Utility starts up and looks for Epiphan devices on the network. 

If an Epiphan device is operating, has an IP address on the network, and is connected 

to the network, the Network Discovery Utility will find it and display information for it.  

 

For each Epiphan device, the Network Discovery Utility displays a name, serial 

number, IP address and status (such as device OK, or Not Found).  

 

If a device is selected and is capturing images, the current captured image should 

appear on the Network Discovery Utility interface and the status of the device should 

be Device OK, shown with a green indicator. If the device is not capturing images the 

Device OK indicator can still appear but the display will not show a captured image.  

 

Note: When you restart the Network Discovery Utility if it has already found an 

Epiphan device it will show the status of the device as Detecting and the indicator will 

be amber. If the Network Discovery Utility cannot find a previously found Epiphan 

device, the status will change to Not Found or Failed and the indicator will be red. 

 

Menus  

 

This section describes the commands available from the Network Discovery Utility 

menus:  

File menu Use the File menu to exit from the 

Network Discovery Utility. 

Device menu From the device menu, you can select an 

Epiphan device in the list and:  

Select Refresh to refresh the selected 

device’s information and stream preview. 

Refresh re-draws the captured image 

thumbnail and updates the name, IP 

address, serial number and status of the 
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device. 

Select Remove to delete the selected 

device from the device list. 

 

View menu Use the commands on the view menu to 

display or hide the Status bar and adjust 

the relative width of the Network 

Discovery Utility left and right panes. 

Help menu On the help menu, select About to display 

the Network Discovery Utility version 

 

 

List of Devices  
 

The left pane of the Network Discovery Utility shows the Epiphan devices that have 

been found on the network and are available to DirectShow applications installed on 

the video capture workstation.  

 

For each device, the list displays a thumbnail of the current captured image (if 

appropriate), the name, serial number, IP address and device status of the Epiphan 

device.  

 

The names of the VGA2Ethernet devices found on your network appear in the 

DirectShow compatible applications that you can use to record captured images. You 

can change these names using the Network Discovery Utility.  

 

You can use the buttons at the bottom of the list to add or remove Epiphan devices 

from the list and to search the network for new Epiphan devices.  

 

You can use the buttons at the bottom of the list:  

Add Add a new Epiphan device to the list by adding a Name for the device 
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and an IP address and selecting Add. As you enter the IP address the 

Network Discovery Utility searches for an Epiphan device that matches 

the IP address. If a device is found the status indicator changes to 

green. If a device is not found the status icon remains red. You can 

add different IP addresses until you add one that matches a device. 

Remove Select an Epiphan device from the list and select Remove to delete the 

device from the list.  

 

Search Select Search to search your network for new Epiphan devices. If an 

Epiphan device is found that is not on the list it is added. 

 

 

Captured Image Display  
 

The right pane of the Network Discovery Utility shows the image captured by the 

device selected in the Epiphan devices list. This pane also displays the resolution and 

refresh rate at which the device is capturing the image.  

 

You can use the following buttons and fields on the right pane:  

Refresh Refresh 

Name Displays the name of the selected 

Epiphan device. The default name is, for 

example, VGA2Ethernet # followed by 

the device’s serial number. This name 

appears in DirectShow applications used 

to record the images captured by this 

device. You can change the name in the 

Name field. This changes the name 

associated with the device in the Network 

Discovery Utility and in DirectShow 

applications.  
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Address The Address field displays the IP address 

of the Epiphan device. You can change 

the IP address if the IP address of the 

selected Epiphan device changes. 

Otherwise if you change the address you 

will lose the connection to the Epiphan 

device.  

 

If you change the Address and lose the 

connection to the Epiphan device, you 

can restore the connection by changing 

back to the correct IP address. Or you 

can remove the Epiphan device from the 

list and then select Search to find it again.  

 

Advanced Configure image adjustments for the 

selected device. You can also configure 

image adjustments from the Web admin 

interface and you can view image 

adjustment settings from the 

VGA2Ethernet user interface.  

 

Configure DirectShow settings for the 

selected device.  

Web Config Open the Web admin interface for the 

selected Epiphan device in a web 

browser. 
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Configuring Image Adjustments  

 

The VGA2Ethernet device automatically adjusts image capture settings every time it 

starts up. The automatic adjustment is repeated every 60 seconds during operation. 

You can change the interval between automatic adjustments from the Web admin 

interface.  

 

You can make manual image adjustments from the Network Discovery Utility or from 

the Web admin interface. The following procedures describe how to make manual 

adjustments from the Network Discovery Utility. For information about making image 

adjustments from the Web admin interface and for details about image adjustment 

settings, see Configuring Image Adjustments.  

 

Note: You can also view image adjustment settings from the VGA2Ethernet user 

interface by selecting Configure Device from the Capture menu and selecting 

Adjustments.  

 

If image adjustments are required, you may need to make them in small increments to 

avoid loss of image synchronization. If image synchronization is lost, the device will 

stop responding and stop capturing images. You may have to wait a few minutes 

before the device will start responding again. You can disconnect the video cable for 

10 seconds to reset image synchronization. You can also reset image synchronization 

by restarting the device. See Rebooting or Restarting VGA2Ethernet. 

 

To configure image adjustments from the Network Discovery Utility  

1. Start the Network Discovery Utility, select a VGA2Ethernet device and select 

Advanced. 

2. Select the image adjustment checkbox setting to change and adjust the slider 

as required. For information about each setting, see Image Adjustment Settings.  

3. Select Apply or OK. The changes are saved to the device. 
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To reset image adjustments from the Network Discovery Utility  

 

The quickest way to reset image adjustments from the Network Discovery Utility is to 

clear all image adjustment checkboxes.  

 

1. Open the Network Discovery Utility. 

2. Select a device. 

3. Select Advanced. 

4. As required, clear the checkboxes for each image adjustment that you want 

to reset. 

6. Select Apply or OK. 

 

Configuring DirectShow Options  

From the Network Discovery Utility, you can select Advanced and then select the 

DirectShow tab to configure DirectShow options. 

 

Fix Resolution Control the image resolution reported to DirectShow and so used 

by DirectShow-compatible applications. You can use this option to 

cause DirectShow to expand or shrink the image recorded by 

DirectShow-compatible video capture applications.  

Default Image Select an image to be sent to DirectShow if the device is not 

sending images to the video capture workstation. This option 

replaces what would otherwise be a blank screen with a static 

image that would be captured by DirectShow-compatible image 

capture applications.  

 

Scaling If Fix Resolution is set to a resolution that does not match the 

actual resolution of the video signal you can select Pixel Resize to 

have the VGA2Ethernet device driver resize the image (either 

shrink or expand it) to match the fixed resolution. Pixel Resize is a 

simple resizing method that adds or removes pixels as required to 
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resize an image.  

If you set scaling to No Resizing the device driver does not resize 

the image sent to DirectShow. If the actual resolution of the video 

signal is smaller than the fixed resolution, the image appears in 

DirectShow compatible video capture applications with a border 

around it. If the actual resolution is larger than the fixed resolution, 

the image appears cropped in DirectShow compatible video 

capture applications.  

 

Flip image 

vertically 

Select this option to turn the captured image displayed on the 

VGA2Ethernet user interface upside down. If you select this option, 

the image in recorded videos, the image that is copied when you 

select Copy from the Edit menu, printed images, and broadcasted 

images are also upside down. Images saved by selecting Save 

from the File menu and recorded image files are not affected by 

this option.  

 

Limit frame rate 

to 

Select Limit frame rate to set a frame rate that is lower than the 

frame rate at which the device can capture images. You can 

reduce the frame rate to reduce the number of images captured by 

the device. You may want to reduce the frame rate to reduce the 

load on the video capture workstation, to reduce network usage, to 

reduce the size of recorded video files, or to reduce the number of 

saved image files.  

For example, the VGA2Ethernet device can capture up to 120 

frames per second (fps). This frame rate may approach 100% CPU 

usage even on a dual CPU video capture workstation. To reduce 

load on the video capture workstation, you can reduce the frame 

rate to 30 fps without losing too much data.  

The valid frame rate range is from 0.01 to 60 fps. The default frame 

rate is 30 fps.  
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Fix frame rate Select fix frame rate to force the frame rate to always be the same 

as the limited frame rate. 

 

 

 

 

8. Recording Image Files  
 

You can use the information in this chapter if you are planning to record frames 

captured by a VGA2Ethernet device as a series of individual image files. 

 

Configuring Image File Recording Options  

 

You should review and modify image file recording options before recording captured 

images as image files. Using image file recording options, you can control the format 

of the image files, control the file naming system used for saving the image files, and 

determine whether to save all captured images or only some.  

 

To configure image file recording options  

1. Start the VGA2Ethernet user interface. 

2. If required, select a VGA2Ethernet device using the Select Device command 

from the Capture menu. 

3. On the Tools menu select Options. 

4. On the Recording tab set Record as to Images. 

Configure the capturing options and select OK to save your changes. 

 

Recording Image Files  
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Before recording captured images as a series of image files, you should configure 

image recording options and optionally configure display format settings.  

To record image files  

1. Connect the VGA2Ethernet device to the video source that you want to 

record from and to the video capture workstation. 

2. On the video capture workstation, start the VGA2Ethernet user interface. If 

required, select the VGA2Ethernet device. 

3. Make sure the VGA2Ethernet user interface is displaying the captured 

images that you want to record. 

4. Select Start Recording from the Capture menu or from the toolbar select 

. 

5. Enter the file name, select the location for saving the video file, and select 

Save. As the VGA2Ethernet device captures images, they are recorded as a 

series of image files according to the image file settings on the Recording tab 

of the Options dialog. The Status bar shows the names and location of the 

image files as the VGA2Ethernet user interface saves them. You can pause 

recording by selecting Pause from the Capture menu or  from the 

toolbar.  

 

6. You can stop recording by selecting Stop Recording from the Capture menu 

or   from the toolbar. When you stop recording, the status bar displays 

the number of image files saved. For example, the message Wrote 31 files 

indicates the VGA2Ethernet user interface saved 31 image files. 

 

 

9. Recording Videos  
You can use the information in this chapter if you are planning on recording the frames 

captured by your VGA2Ethernet device as video files. 
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Recording Videos Using the Epiphan VGA2Ethernet 
user interface  

 

This section describes how to use the Epiphan VGA2Ethernet user interface to record 

video files on a video capture workstation running Windows 2000, XP, Vista or 7.  

 

Videos are recorded in Windows *.avi file format. The *.avi files are created and saved 

by an external codec that must be installed on the video capture workstation. To 

record video, you first install an external third-party video codec and then add that 

codec to the VGA2Ethernet user interface configuration. The Epiphan VGA2Ethernet 

user interface passes captured images to the video codec for recording. 

 

Selecting a Windows Video Codec  

The VGA2Ethernet user interface automatically finds all of the video codecs installed 

on the video capture workstation. Unless you have already installed a high-speed 

codec, most of the codecs that the VGA2Ethernet user interface finds may be too slow 

or have poor compression. If a codec is too slow, the video recording frame rate may 

be too low to produce a good quality video without compromising the performance of 

the video capture workstation. If a video codec has poor compression, the recorded 

*.avi files could become very large.  

 

To view the codecs installed on the video capture workstation  

1. Start the Epiphan VGA2Ethernet user interface. 

2. Select Options from the Tools menu. 

3. Select the Recording tab. 

4. Set Record as to Video. 

5. Select the Select Codec button. 

7. Select the Compressor list to view the list of video codecs available on the 

video capture workstation. 

Although a number of codecs may be available, Epiphan recommends that you select 

a third-party codec to purchase or download that will meet your requirements. Select a 
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video codec that can record videos at a high frame rate and that also supports high 

quality compression.  

 

Epiphan recommends the MS MPEG 4 V2 video codec for most applications. You can 

use this codec to produce *.avi files that are compatible with most *.avi players. This 

codec operates at high refresh rates without reducing the performance of the video 

capture workstation and also includes high quality compression. 

 

Installing the ffvfw Video Codec Pack  

The MS MPEG 4 V2 video codec is available in the free ffvfw codecs pack. You can 

download the ffvfw codecs pack from http://www.free-codecs.com/download/ffvfw.htm.  

To download and install the ffvfw video codec pack  

1. Make sure the Display Format is set to RGB 24 bits per pixel. 

2. Check by selecting Options from the Tools menu and selecting Display.  

3. Select the following link to download the ffvfw codec pack: 

http://www.free-codecs.com/download_soft.php?d=313&s=205  

This link starts a download of the file ffvfw-20031028.exe, which is the installer for the 

ffvfw codec pack.  

4. Download this file and then run the executable to install the ffvfw codec pack.  

5. From the VGA2Ethernet user interface, select Options from the Tools menu. 

6. Select the Recording tab. 

7. Select Record as Video. 

8. Select the Select Codec button. 

9. In the Compressor list select ffvfw MPEG-4 Codec. 

10. Select Configure. 

11. Select the following settings for the ffvfw codec pack: 

Encoder MS MPEG4 v2 

FOURCC MP42 

Mode one pass - quality 

Quality Between 1 and 100 

 

http://www.free-codecs.com/download_soft.php?d=313&s=205%20
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Selecting a higher quality may reduce the frame rate and increase the size of the 

video files produced by the codec. You may want to experiment with the quality setting 

to achieve optimum results.  

You may not need to change other settings unless you have special requirements. 

Select OK three times to save your changes. 

 

Recording a Video  

 

Before recording captured images as a video you should:  

- Set the display format to RGB 24 bits per pixel  

- Install and configure a video codec   

- Configure video file recording options  

- Review video recording options  

To record video files  

1. Connect the VGA2Ethernet device to the video source that you want to 

record from and to the video capture workstation. 

2. On the video capture workstation, start the VGA2Ethernet user interface. 

3. Make sure the VGA2Ethernet user interface is displaying the captured 

images that you want to record.  

4. Select Start Recording from the Capture menu or from the toolbar select 

. 

5. Enter the file name, select the location for saving the video file, and select 

Save. 

 

As the VGA2Ethernet captures images, they are recorded to a video file. The 

Status bar shows the name and location of the video file. The status bar also 

displays the amount of time that the video has been recording and the number of 

frames (or images) recorded. When the size of the video file reaches the AVI file 
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size limit, (see AVI file size limit) the VGA2Ethernet user interface does one of the 

following:  

- stops recording. 

- starts a new video file and continues recording. (Configuring Video File 

Recording Options describes how to specify the file name.) 

- overwrites the original video file and continues recording. 

 

You can pause recording by selecting Pause from the Capture menu, the key 

combination Ctrl+U or  from the toolbar.  

 

You can stop recording by selecting Stop Recording from the Capture menu or  

from the toolbar. When you stop recording, the Status bar displays the name 

and location of the saved video file, for how long the video file was recording, and the 

number of frames (or images) recorded. For example: Wrote c:\temp\example.avi (85 

sec, 464 frames). 

 

 

Playing Back a Video File  

 

Depending on the video codec that you used, you should be able to play back 

most recorded videos using Windows Media Player. If you are playing back the video 

file on a computer other than the video capture workstation, you may need to install a 

video codec on that computer. See “Installing the ffvfw Video Codec Pack”. You 

cannot use the Epiphan VGA2Ethernet user interface to play back video files. 

 

 

Recording Videos for Mac OS X  
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This section describes how to record video files on a video capture workstation 

running Mac OS X. You must first install the Epiphan device driver and Epiphan 

QuickTime component on the video capture workstation and then make records using 

a QuickTime-compatible video recording application.  

 

Apple QuickTime is the standard Mac OS X QuickTime multimedia API. The 

Epiphan capture API sends captured images to the Epiphan QuickTime component. 

The Epiphan QuickTime component sends the captured images to QuickTime where 

they can be recorded or otherwise processed by any QuickTime-compatible video 

recording application such as HackTV Carbon or QuickTime Pro. 

 

Setting QuickTime Options for Recording Videos  

 

Before starting to record videos you should configure Epiphan QuickTime 

integration options by opening System Preferences, selecting VGA2USB under Other, 

and configuring QuickTime settings for the devices that you will be recording video 

from. QuickTime options set some optional default settings used by some QuickTime 

applications.  

To add or remove a network device  

1. To add a device, select the plus sign at the bottom left of the window. 

2. Enter the IP Address of the device you want to add or click on the triangle 

beside the Network Address box and select the device from the list of 

networked devices. 

3. Select Connect. 

4. To remove a device select the device and select the minus sign. 

 

Recording Video Files (Mac OS X)  

In addition to setting QuickTime Options you need to install a QuickTime-compatible 

video recording application such as QuickTime Pro, HackTV Carbon or WhackedTV. 

QuickTime Player is included in Mac OS X distributions. You can buy a QuickTime Pro 

licence from Apple to enable recording for your QuickTime Player. HackTV Carbon is 

a free application that works on older Mac systems. WhackedTV is also a free 
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application for use with newer Mac systems. Both HackTV Carbon and Whacked TV 

are non-commercial software with useful functionality but a limited user interface and 

no end user documentation or Help. 

 

 

Playing Back a Video File (Mac OS X)  

 

You can play a QuickTime video using QuickTime or any QuickTime-compatible video 

player. 
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10.  Cables, Connectors and Adapters 
 

VGA2Ethernet can connect to a number of different interfaces cables, and adapters. 

This chapter describes a subset of connectors, cables and adapters that can be used 

with the VGA2Ethernet device.   

 3.5 mm Mini-jack  

A 3.5mm mini jack connector is used to carry audio signals. It can be connected to 

VGA2Ethernet via Audio IN port. 

 
 

 

DVI 

A DVI cable can be connected to VGA2Ethernet via DVI IN and OUT ports. 
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VGA 

A VGA Cable can be connected to VGA2Ethernet via DVI IN and OUT ports with the 

help of the DVI to VGA adapter (shown below).  

 
 

DVI to VGA cable.   

Connects VGA sources to a VGA2Ethernet’s DVI port. 

 



Cables, Connectors and Adapters  

 

107 VGA2Ethernet User Guide 
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RJ-45 Male 
 

Ethernet RJ-45 connector:  Used to connect VGA2Ethernet to the Ethernet network. 

 

 
 

Composite Video to DVI Converter 
 

Used to connect VGA2Ethernet to composite video sources. 
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8. Sample Applications  
 

The following section describes a number of applications and scenarios for using 

VGA2Ethernet.  

 

Sharing Data without Using Guest-access Networks 

If the company has strict security requirements in a computing environment, 

VGA2Ethernet can offer Internet access to the companies’. The VGA2Ethernet 

solution provides to visitors a possibility to share safely their presentations and other 

information within the company without accessing company servers or sensitive 

networks. There’s no need to plug visitor PCs into the corporate network or allow 

guests to use USB inputs for sharing information. VGA2Ethernet connects to the 

visitors’ devices outputs and captures information transferring it through the Ethernet 

without connection to the corporate LAN. 

 

 
 

 

Performing Presentations over Ethernet 

Organizations perform business presentations for different purposes. Remote 

participants watch the presentations in an Internet browser. The presentations content 

is sent over Ethernet using VGA2Ethernet. VGA2Ethernet grabs either DVI or VGA 
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signal from any device being used as a presentation source and transfers it to the 

remote users through the Ethernet connection. 

 

 
 

 

Recording Training Sessions and Lecture Capture 

VGA2Ethernet can be used to record training, usability testing or simulations. 

Recorded trainings can be used in coaching and feedback both by facilitators and 

participants. VGA2Ethernet captures training sessions from DVI and analog cameras, 

sends video over Ethernet and records on a target computer. Besides, it makes the 

recorded sessions accessible to others, edited and post-produced by video editing 

software. 
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Environmental Information  

The equipment that you bought has required the extraction and use of natural 

resources for its production. It may contain hazardous substances that could impact 

health and the environment.  

In order to avoid the dissemination of those substances in our environment and to 

diminish the pressure on the natural resources, we encourage you to use the 

appropriate take-back systems. Those systems will reuse or recycle most of the 

materials of your end life equipment in a sound way.  

The crossed-out wheeled bin symbol invites you to use those systems. If you need 

more information about collection, reuse and recycling systems, please contact your 

local or regional waste administration. You can also contact us for more information on 

the environmental performance of our products.  

 

FCC & CE Compliance Statement 

 

This device complies with Part 15 of the FCC Rules. Operation is subject to the 

following two conditions: 

(1) This device may not cause harmful interference 

(2) This device must accept any interference received, including interference that may 

cause undesired operation. 

Marking by the symbol indicates compliance of this device with EMC directive of 

the European Community and meets or exceeds the following technical standard.  

EN 55022 - Limits and Methods of Measurement of Radio Interference Characteristics 

of Information Technology Equipment. 
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Other Jurisdictional Issues  

Epiphan makes no representation that its products or information in this document or 

its web site is appropriate or available for use in your jurisdiction. Those who choose 

to access the Epiphan web site or use Epiphan products do so on their own initiative 

and are responsible for compliance with local laws, if and to the extent local laws are 

applicable.  

 

Submissions to Epiphan and Affiliated Servers  

Any information, including but not limited to remarks, suggestions, ideas, graphics, or 

other submissions, communicated to Epiphan through their Epiphan web site is the 

exclusive property of Epiphan. Epiphan is entitled to use any information submitted for 

any purpose, without restriction (except as stated in Epiphan's Privacy Statement) or 

compensation to the person sending the submission. The user acknowledges the 

originality of any submission communicated to Epiphan and accepts responsibility for 

its accuracy, appropriateness, and legality.  

 

Third Parties and Links to Third-Party Web Sites 

Mention of non-Epiphan Systems Inc. products or services on their website, or this 

document site is for informational purposes and does not constitute an endorsement 

or recommendation.  

 

This document may contain links to non-Epiphan web sites. These links are provided 

to you as a convenience, and Epiphan is not responsible for the content of any linked 

web site. Any outside web site accessed from the Epiphan web site is independent 

from Epiphan, and Epiphan has no control over the content of that web site. In 

addition, a link to any non-Epiphan web site does not imply that Epiphan endorses or 

accepts any responsibility for the content or use of such a web site.  

In no event shall any reference to any third party or third party product or service be 

construed as an approval or endorsement by Epiphan of that third party or of any 
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product or service provided by a third party.  

 

Miscellaneous 

It is the user's responsibility to ascertain whether any information downloaded from the 

Epiphan web site or other websites is free of viruses, worms, trojan horses, or other 

items of a potentially destructive nature.  

 

Enforcement of Terms and Conditions  

These Terms and Conditions for use of this document and the associated Epiphan 

Product are governed and interpreted pursuant to the laws of the province of Ontario, 

Canada, notwithstanding any principles of conflicts of law.  

 

All disputes arising out of or relating to these Terms and Conditions shall be finally 

resolved by arbitration conducted in the English language in Ottawa, Ontario, Canada 

under the commercial arbitration rules of the Canada. The parties shall appoint as sole 

arbitrator a retired judge who presided in the province of Ontario. The parties shall 

bear equally the cost of the arbitration (except that the prevailing party shall be entitled 

to an award of reasonable attorneys' fees incurred in connection with the arbitration in 

such an amount as may be determined by the arbitrator). All decisions of the arbitrator 

shall be final and binding on both parties and enforceable in any court of competent 

jurisdiction. Notwithstanding this, application may be made to any court for a judicial 

acceptance of the award or order of enforcement. Notwithstanding the foregoing, 

Epiphan shall be entitled to seek injunctive relief, security, or other equitable remedies 

from any court of competent jurisdiction.  

If any part of these terms is unlawful, void, or unenforceable, that part will be deemed 

severable and will not affect the validity and enforceability of the remaining provisions. 

Epiphan may, at its sole discretion and without notice, revise these terms at any time 

by updating this posting. 

 

Copyright © 2011 Epiphan Systems Inc.  

All Rights Reserved. 



List of Figures  

 

116 VGA2Ethernet User Guide 

 

Configuration Worksheet 

 

Use this worksheet to keep necessary information about VGA2Ethernet installation, 

settings etc. 

 

Parameter (IP address, DNS 

server, SSID…) 

Value 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

 

Notes: 
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